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About Our Documentation 
The Spitfire Project Management System (sfPMS) is extensive and 
powerful.  Learning about all that you can do with it takes time.  To help 
you learn, we provide various forms of documentation.  Because one 
large all-inclusive manual would be too unwieldy and take too long to 
download, we provide smaller units of documentation—guides, 
knowledge base articles, and technical white papers. 

Guides 
Our guides, which include an Overview Guide and various other guides, 
focus on specific areas or tasks in sfPMS.  Often, one Focus Guide will 
refer you to a second Focus Guide when an overlapping section is 
described in more detail in the second guide.  By reading the guides, you 
will get a good understanding of the system in general and you will learn 
procedures for how to do many of the things that sfPMS allows you to 
do.  We suggest you read the Overview Guide first, followed by other 
Focus Guides as needed. 

To access the guides: 

1. Log in to sfPMS. 

2. Click Help at the top of the Spitfire Dashboard: 

 
3. Select either Overview Guide or one of the choices under 

Focus Guides: 
 
The guide will appear as a PDF file. 
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White Papers 
White Papers (also known as Technical White Papers or TWPs) are 
documents that delve into some of the more technical aspects of sfPMS.  
White Papers are accessed through the same Help menu: 

 

The Knowledge 
Base 

The Knowledgebase contains articles, in a question-and-answer format, 
that cover either more specific or more technical information about 
sfPMS.  The Knowledgebase is accessed through the same Help menu 
as the guides: 

 
Articles in the Knowledge Base are numbered, for example, KBA-01044. 
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Introduction to This Guide 
In Spitfire, the term “document” is used to describe a specific entity 
created in sfPMS from a document type (Doc type).  There are many 
Doc types in the system, each with its own specific purpose.   

This guide focuses on the Doc types available in Spitfire-Enterprise, 
which you might use during possible project workflows.  In actuality, you 
might skip some of the Doc types mentioned or create and use custom 
Doc types.   

This guide assumes some familiarity with sfPMS and its dashboards as 
described in the Overview Guide and with basic document and item 
information as described in the Focus on Document and Item Basics 
guide. 

In addition, a summary of all Doc types is available in the Quick Doc 
Type Reference technical white paper. 

 

Note: Because Doc types are configured during implementation, the Doc 
types and specific documents shown as examples in this guide might not 
be the same as the ones used in your own system.   

 

Note: Aside from updated pictures and icons, the information herein is 
the same as the information in the V4.4 documentation.  Also, icons are 
shown in size 16 only; larger sized icons are similar but not exactly the 
same. 
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The Big Picture 
Project 

Workflow 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Note: Not all Doc types are included in this workflow.  For a complete 
alphabetical list of all Doc types, see page 17. 

Punch List 
(page 52) 

Meeting Minute 
(page 54) 

RFI 
(page 145) 

Bid Package (page 73) 

RFQ (page 68) 

Commitments (page 83) 

Submittal (page 90) 

Change Orders (page 156) 

Compliance 
Notifications 
(page 101) 

-Status=Committed 

CCOs (page 116). 

Pay Requests (page 109) 

-Status=Approved 

Vouchers (page 189) 
Other 
sources 

Expense Budget 
Updated  

Contract Value 
Updated  

Bid (page 18) Project Setup (page 25) Status=Won 

-Status=Committed 

Initial Budget (page 38) 

Budget Revisions  

SOV (page 42) 

POs (page 191) 

Proposed CO (page 150) 

Drawings 
(page 60 ) 

Charge Entry [non-
integrated only] (page 174) 

-Status=Approved 

Actual Cost 
Updated  

Daily Field Report 
(page 130) 

Issue 
(page 142) 

Invitation to Bid (page 63) 

Bid Package Addendum (page 79) 
   
 

Submittal Package 
(page 90) 

Forecast (page 161) 
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sfPMS and 
Integrated 

Accounting 
sfPMS can be integrated with Microsoft Dynamics SL or Acumatica 
Cloud ERP. 

• Projects are created in sfPMS and sfPMS in turn creates the 
corresponding project in the integrated accounting system. 

• Contract value, Budgets and Change Orders are entered and 
maintained in sfPMS and sfPMS posts the data to the integrated 
accounting system. 

• Commitments/Subcontracts are created and maintained in 
sfPMS and populate the integrated accounting system. Note: 
with Microsoft Dynamics, the Financial Transaction Transfer 
functions calculate and maintain Actuals and Commitments. 

• Pay Requests are entered and approved in sfPMS, then posted 
in the integrated accounting system to create AP Vouchers  

• Other job cost transactions (labor, expenses, overhead, etc.) and 
billings are entered and maintained in the integrated accounting 
system and sfPMS reads and displays the data.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

 

 

 

 

sfPMS Microsoft Dynamics SL 

Create Project Project Created 

Commit Contract Value Budget Revision with 
Contract Value 

Enter and Approve Initial 
Budget 

Budget Revision Posted 
Tasks assigned to Project 

Enter RFQ and Commit 
Commitments/Subcontracts 

Run FTT to Calculate 
Commitment Amounts 

Create/Process Spitfire-only 
Doc types (RFIs, Submittals,  
Meeting Minutes, Punchlists, 

etc.) 

Enter and Approve Pay 
Requests 

Post Payment Request to 
create AP Voucher 

Maintain Budgets, Forecasts 
and Change Orders 

Budget Revisions Posted 

Displays in BFA, KPI, Cost 
Analysis and Executive 

Dashboard 
(Drill-down to Transactions) 

Enter Labor Transactions & 
other Job Cost Charges 

Process Billing 

SOV Billing Flexible Billing 
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sfPMS  Acumatica 

Company/Divisions  Company 

Contacts  Customers, Vendors, Employee 

Project ID, Cost Codes (aka Tasks)  Project ID, Tasks (aka Cost Codes) 

Account Categories  PM Account Groups (PM201000) 

  GL Accounts/PM Group mapping 

Projects  Projects (PM301000) 

Tasks  Project Tasks (PM30200) 

Budgets – on approval  Project Budget (PM303000) 

Team – employees only  Projects (PM301000) | Employee tab 

Commitments  (none) 

Pay Requests – on approval  

Bills And Adjustments (AP30100) 
Project Transactions (PM304000) 
Projects (PM301000) | Balances tab 

Vouchers  

Bills And Adjustments (AP301000) 
Project Transactions (PM304000) 
Projects (PM301000) | Balances tab 

SOV Pay App – on invoice  

Invoices and Memos (AR301000) 
Project Transactions (PM304000) 
Projects (PM301000) | Balances tab 

Customer Invoice  Invoices and Memos (AR301000) 

Actuals 
 Project KPI/Project BFA 
 Project Cost Analysis 

 
Project Transactions (PM304000) 
Projects (PM301000) | Balances tab 
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Alphabetical Index 
The chapters in this guide describe the various Doc types in a somewhat 
logical order.  If you want to jump to a specific Doc type, the following 
alphabetical listing might prove helpful. 

Doc Type On Page Doc Type On Page 
AP Vouchers 189 Milestone 135 
AR Invoice 191 Pay Application 42 
Bid 18 Pay Request 109 
Bid Package 73 Pct Billing 191 
Bid Package Addendum 79 Period Distribution 164 
Budget 38 Permits 58 
Cash Trans 191 PO 191 
Catalog File Route 182 Production Units 178 
CBE 191 Project Dashboard Photo 128 
CCO 116 Project Setup 25 
Certificates and Approval 140 Project Setup Info 35 
Change Item Register 154 Proposed CO 150 
Change Order 156 PunchList 52 
Charge Entry 174 Receipt 104 
Commitment 83 Requisition 191 
Compliance Notification 101 RFI 145 
Correspondence 131 RFQ 68 
Customer 184 Safety Notice 138 
Daily Field Report 130 Scanned Timecards 124 
Drawings 60 Schedule 50 
DSL – SPR 191 Service Call Entry 191 
Employee 184 Service Contract 167 
Estimate 22 Service Ticket 169 
Expense Entry 171 Site Photo 126 
Field Work Order 136 Submittal 90 
File Batch 120 Submittal Item Register 90 
Forecast 161 Submittal Package 90 
GL Journal Trx 191 Task 132 
Inspection 137 Team Message 139 
Inv & Adj 191 Timecard 191 
Invitation to Bid 63 Timesheet 191 
Issue 142 Transmittal 107 
Item Request 191 Vendor 184 
Lien Waiver 48 Warranty 131 
Meeting Minutes 54   

 
TIP 
If you click on a link to 
get to another page in 
this guide, you can use 
the Alt + (left arrow) 
keys to return to the 
previous view. 
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Bid 
Overview 

Bid documents keep track of all your bids for prospective projects.   

 

 

 

Where It Fits In 
A Bid document is usually created before a project.  Often, it is the first 
document you create in a project’s workflow.  One or more Estimate 
documents can be attached to the Bid document.  The Bid document can 
lead to a Project Setup document. 

Note: you can also create a Bid document from a Project Dashboard, if 
you want to create the Bid document after you have created the Project 
Setup document.  In such a situation, use the lookup on the Bid 
document to find the Project number to associate with the Bid. 

Click  to open the Document Options Menu;  to save the document;  to keep 
exclusive update rights; and  to hide the details of the Document Header. 
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Creating a Bid 
To create a Bid document: 

1. Click  or your name to open the Site Options menu, then 
select  Create Document from the Site Options menu: 

 
2. Select Create Bid. A Bid document window will open. 

3. If you want to potentially create the Project Setup from this Bid, 
leave the Project field blank. When you win the bid and create a 
Project Setup document, this field will be filled in automatically.  

4. Enter a useful description in the Description field.  This text will 
also be used as the title. 

5. Look up a Customer.  The customer must be a Contact in 
sfPMS.   

6. Click  to save (and actually create) the document. 

7. (optional) On the Details tab, select a Type that will pass onto 
the Project Setup if the Bid is awarded.  The type represents a 
Bid subtype. 

 
8. (optional) On the Details tab, select a Contract Type that will 

pass on to the Project Setup if the Bid is awarded. 

 
9. Add New Items on the Items tab.  This can be one Item that 

indicates your total Bid amount, or several Items that break down 
your Bid amount.  For each item, 

TIP 
If your customer is not 
already in sfPMS and you 
do not want to enter all 
potential customers into 
sfPMS, you (or your 
System Administrator) 
can create one Contact 
called “Potential 
Customer” to use at this 
point.  If the Bid leads to 
a project, the customers 
Contact information can 
be entered into sfPMS 
then.  You will be able to 
change the Customer 
field on the Project Setup 
document. 

TIP 
For more information 
about the Items tab, see 
the Focus on Document 
and Item Basics guide.   
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o See if the Include checkbox is as you want it. 

 
All Items that are “included” are added together to determine the 
Bid Amount found on the Details tab. 

10. Add other information to the document, add attachments (for 
example, spreadsheets or Estimate documents) and create a 
route as appropriate. 

11. (optional) If an Attachment template has been established for 
this Doc type,  will appear on the Attachments tab.  Click on 

 to create the printout file for the Bid.  This printout will be 
emailed or faxed to potential customers who are set up as “via 
email” or “via fax” routees.  

12. Either route the document to another person or save the 
document, then close the document window. 

13. You can reopen the document as needed to make changes to it 
and to change its status.  

o As long as you don’t route the Bid document, it will 
remain in your Inbox (on the Home Dashboard).   

o If the Bid document has been routed back to you, it will 
be in your Inbox. 

o If you need to find a Bid document that is not in your 
Inbox, use the Type filter (and Include Closed filter, if 
the Bid status is Awarded) on the Catalog Dashboard: 

 
o If you lose the bid, change its status to Lost.  If you win 

the bid, change the status to Awarded.  (The status 
must be Awarded before you can create a Project Setup 
document.) 

 

TIP 
If you need to get bids 
from your own vendors 
before you can determine 
your bid for this potential 
project, you can create a 
Bid Package document 
through the Document 
Options menu.  See  
the next page. 

TIP 
For more information 
about the Catalog, see 
the Focus on Files, 
Attachments and the 
Catalog Dashboard 
guide. 

TIP 
For more information 
about attachments, see 
the Focus on Files, 
Attachments and the 
Catalog Dashboard 
guide.  For more 
information about routes, 
see the Focus on Routes 
guide. 



 Page 21 

Focus on Doc Types and Project Workflow  Bid 

Bid Options 
Menu 

The Options menu for the Bid document offers the following choices after 
you first save: 

 

Of Particular Note 
•  indicates the Source Contact (person or company getting the 

bid) for this document.  This option appears only after you look 
up a choice for the Customer. 

• The choice to  Create Bid Package allows you to create one 
or more Bid Package documents (see page 73) to obtain quotes 
before you send out your own Bid.  This option appears only if 
you created the Bid from the Site Options menu. 

• If you set the status to Awarded (and save), the Bid Package 
option is replaced with a  Create Project Setup option (see 
page 25): 

 

Statuses for Bid 
By default, the Status drop-down offers the following choices: 

 
• In order to create a Project Setup document from a Bid, the 

status must be set to Awarded. 

• Lost and Awarded are final statuses, which close the document 
and make it read-only.  When a Bid document is Lost or 
Awarded, it can no longer be changed. 

 

 

 

 

Lost 

Awarded 

Need More Info 

In process 

Out for Bid 

TIP 
A “Bid Analysis” report 
and a “Bid Analysis by 
Customer” report are 
offered by sfPMS.  See 
the technical white paper 
Spitfire Reports for more 
information. 

TIP 
A description of all 
Document Options menu 
choices can be found on 
in the Focus on 
Document and Item 
Basics guide.  
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Estimate 
Overview 

Estimate documents largely serve as “wrappers” for routing attached 
estimate workbooks in Microsoft Excel.   

 

Where It Fits In 
An Estimate document is usually created before, or in the earliest stages 
of, a project.  Estimate documents with attached Microsoft Excel files are 
usually attached to Bid documents.  If and when the Bid leads to a 
Project Setup, the Estimate document is automatically included in the 
project.  Once part of a project, the Estimate’s attached spreadsheet can 
be used when importing data for the Initial Budget. 

Note: if it fits better into your workflow, you can attach estimate files 
directly to your Bid document, bypassing the Estimate document.  
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Creating an 
Estimate 

To create an Estimate document: 

1. Select Create Document from the Site Options menu: 

 
2. Select Create Estimate. An Estimate document window will 

open. 

3. If no project exists yet for this estimate, leave the Project field 
blank. If you attach this Estimate to a Bid and then create a 
Project Setup from that Bid, this field will be filled in 
automatically.  

4. (optional) Enter a more useful description in the Description 
field.  This text will also be used as the title. 

5. Click  to save (and actually create) the document. 

6. If you are creating your estimate spreadsheet from a Microsoft 
Excel Attachment template, click  on the Attachments tab. 

o Give a name to the file, which will be attached to your 
document. 

o Enter your information in Microsoft Excel. 

o Save and close Microsoft Excel. 

7. Add other information to the document (such as a Note), and 
create a route if appropriate. 

8. Either route the document to another person or save the 
document, then close the document window. 

9. You can reopen the document as needed to make changes to it 
and to change its status. You can also edit the attached file to 
update its information. 

o As long as you don’t route the Estimate document, it will 
remain in your Inbox (on the Home Dashboard).   

o If the Estimate document has been routed back to you, it 
will be in your Inbox. 

o If you need to find an Estimate document that is not in 
your Inbox, use the Type filter on the Catalog 
Dashboard: 

 
 

TIP 
For more information 
about the Catalog and 
attachments in general 
and the Attachment 
template feature in 
specific, see the Focus 
on Files, Attachments 
and the Catalog 
Dashboard guide.   

TIP 
For more information 
about routes, see the 
Focus on Routes guide. 

TIP 
If Create Estimate does 
not appear as an option, 
see your Implementer.  
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10. To attach the Estimate document to a Bid, open the Bid 
document and use the  icon on the Bid’s Attachments tab. 

Note: you can also create an Estimate document from a Project 
Dashboard, if you want to create the Estimate document after you have 
created the Project Setup document.  In such a situation, use the lookup 
on the Estimate document to find the Project number to associate with 
the Estimate. 

Estimate 
Options Menu 

The Options menu for the Estimate document offers the following 
choices after you first save: 

 
 

 

Statuses for 
Estimate 

By default, the Status drop-down offers the following choices: 

 
• Closed is a final status, which closes the document.  When an 

Estimate document is Closed, it can no longer be changed. 

 

 

 

 

TIP 
A description of all 
Document Options menu 
choices can be found on 
in the Focus on 
Document and Item 
Basics guide.  

Open Closed 
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Project Setup 
Overview 

The Project Setup document, containing project contract information, is 
the premier document for your project.  Once the Project Setup is 
created and saved, you can access that project’s dashboard and create 
other documents. 

 

Where It Fits In 
Because the Project Setup document creates the Project Dashboard, 
you have only one Project Setup document per project.  A Project Setup 
document may have a Bid and/or Project Setup Info document attached 
to it.  When the Project Setup is first saved, an Initial Budget document 
and a Submittal Item Register document are created automatically for 
the project.  A Project Setup document also creates the first Pay 
Application document.   

Click  to attach another Project 
Setup document to this one.  (See 
the technical white paper Data and 
Equipment Projects for more 
information about linked projects.) 
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Project Field  
At first, the Project field may consist of up to six segments (depending 
on your implementation).  Some segments may be lookups, for example: 

 
• Always fill in segments from left to right. Tab to get from one field 

to another. 

• After you save the document, all segments (with dashes) appear 
in the one Project field, which can no longer be edited: 

 
Note: if you have been given the SYS | Change Project ID (RS) role 
capability, you can change the Project ID as long as there are no actuals 
on the project.  See the Project Setup Options Menu on page 29. 

Optional Sales 
Tax Fields 

Through customization, a sales tax rate field (and corresponding tax ID 
lookup) can be included on your Project Setup document.  These fields 
establish a tax rate for your project.  This tax rate, in turn, is used to 
calculate taxes on your Schedule of Values. (See also page 43). 

 

Creating a 
Project Setup 

There are two common ways to create a Project Setup document: 

• From a Bid document with a status of Awarded 

• Manually, without a Bid document 

 

To create a Project Setup from a Bid: 

1. Open the Bid document.  Make sure its status is set to Awarded. 

2. Open the Document Options menu and select  Create 
Project Setup: 

TIP  
See your System 
Administrator, 
Implementer, or the 
Focus on System 
Administration guide for 
more information on 
customization. 

TIP 
Once you save a Project 
Setup, the Project code 
will automatically be 
entered in the Bid 
document (and Estimate 
document if the Estimate 
was attached to the Bid) 
and the Project Setup will 
appear as an attachment 
on the Bid document. 
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A Project Setup document will open.  You can close the Bid 
document window. 

3. Continue with step 2 of the following instructions, keeping in 
mind that some information from the Bid document will have 
been copied to the Project Setup document (for example, the 
Description, Customer, Contract Type, and included Items).  You 
can enter or change any of these if necessary. 

 

To create a Project Contract manually: 

1. Either select  Create Project from the Site Options menu: 

 
-or- 
Click  at the bottom of the Project List part of the Home 
Dashboard: 

 
A new Project Setup document will open. 

2. Look up a Project code (according to how your Project ID is 
masked). If the project number is filled in automatically, you can 
change this number as long as you don’t use an existing project 
number.  

3. Change the Description to something related to your project. 

4. Look up a Customer. 

5. If not already filled out on the Details tab, look up a Division ID.  
This is a required field. 

6. Click  to save (and actually create) the document. When you 
save your Project Setup, a new Project Dashboard will be 
created and opened. 
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7. (optional) In the Details tab, select a Type (document subtype) if 
appropriate (e.g., if the project will be a Data or Equipment 
project).   
Note: for information about Data and Equipment projects, see 
the technical white paper Data and Equipment Projects. 

8. (optional) In the Details tab, select a Contract Type for the 
project. 

9. Click on the Dates tab and enter a Start and Finish date for the 
project at the Project Current row. 

o You can add other dates as needed. 

10. Add at least one Item in the Items tab.  The amount entered for 
each Item will be totaled for the Contract Value.  (The Contract 
Value is listed as “Original Amount” on the Details tab and also 
as “Original Contract” on the Key Performance Indicators part of 
the Project Dashboard.) When the Project Setup status is set to 
Committed, the Contract Value can be configured to also 
update your Budget. 
Note: it is possible that the Project Setup document was 
configured so that no Item is required. 

11. When you have a contract date, add that date to the Executed 
field on the Document Header. 

12. Add other information to the document, add attachments and 
create a route as appropriate. 

13. Either route the document to another person or save the 
document, then close the document window. 

14. You can reopen the document as needed to make changes to it 
and to change its status.   

 
To reopen a Project Setup document: 

• On the Project Dashboard, click  on the Document Menu: 

 
 
-or- 
Select  Project Setup from the Project Options menu: 

 

TIP 
Changes you later make 
to the Date tab’s Start 
and Finish dates will 
propagate to matching 
Commitment dates, if 
any. 

TIP 
For more information 
about the Items tab, see 
the Focus on Document 
and Item Basics guide.  
For more information 
about attachments, see 
the Focus on Files, 
Attachments and the 
Catalog Dashboard 
guide.  For more 
information about routes, 
see the Focus on Routes 
guide. 
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Project Setup 
Options Menu 

The Options menu for the Project Setup document initially offers the 
following choices after you save: 

  

Of Particular Note 
•  indicates the Source Contact (person/company with whom 

you have the contract) for this document.  This option appears 
only after you look up a choice for the Customer. 

• The  option to open the Initial Budget document (see page 
38) appears only if the status is not yet Committed. 

• After you set the status to Committed (and save), the Initial 

Budget option is replaced with a Create Pay Application 
option (see page 43): 

 

• An option to  Uncommit Project may appear after the status 
is set to Committed, depending on your permission level.  This 
option  

o sets the document status back to In Process; 

o creates and posts a budget revision with the contract 
value (and revenue, if applicable) netted out; 

o adds a revision to the Project Setup document; 

o flushes the project metrics cache (KPI, Cost Analysis, 
etc.) 

• The option to  Change Project ID may appear, depending on 
your permission level.  This option allows you to change the 
Project ID: 
 

TIP 
A description of all 
Document Options menu 
choices can be found on 
in the Focus on 
Document and Item 
Basics guide.  
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Statuses for 
Project Setup  

By default, after you save the document, the Status drop-down offers the 
following choices: 

 
• Once a project is Committed, you change Items through 

Change Orders (see page 156).  In addition, the drop-down 
offers different choices: 

  
 
Most of the time during your project, the document status will be 
Committed. 

• Canceled and Completed are final statuses, which close the 
document, making it read-only. When a Project Setup document 
is Canceled or Completed, it can no longer be changed. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Canceled 

In Process 

Committed 

Completed Plan 

TIP 
A “Project Log” is offered 
by sfPMS.  See the 
Spitfire Reports technical 
white paper. 
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The Project 
Dashboard 

Options Menu 
When you first save your new Project Setup document, sfPMS creates 
the Project Dashboard for that project.  There is one dashboard for each 
project.  At the top of the Project Dashboard is the Options Menu, 
accessed through , which leads you to various project data: 

 
 

Note: the Project Options menu is slightly different on an Equipment 
Project Dashboard (see the technical white paper Data and Equipment 
Projects): 

 Refresh Page  
Use this option to refresh data on the Project Dashboard. 

 Cost Code 
Maintenance  

Use this option to review and edit the Cost Codes in your project through 
the Cost Code Maintenance window. 

 
You can edit the following information for your Cost Codes: 

• Description 

• Contract Type 

• UOM (Unit of Measure) 

• SOV Line 

• Status (Active, Inactive or Plan) 
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• % (Percent Complete) 

• Costing Method 

• Scheduled Start and Scheduled Finish dates 

 Project 
Accounting Maint  

Use this option to open the Project Maintenance window in Microsoft 
Dynamics SL, if your site is integrated with Microsoft Dynamics SL. 

 Project Address  
Use this option to display the project’s address. 

 

 Project 
Location Map 

Use this option to see the project location (as indicated in the project 
address) in Google Maps. 

 Competitive Bid 
Analysis 

Use this option to open CoBRA (the Competitive Bid Response Analysis 
workbook).  This Microsoft Excel workbook will contain a tab for each Bid 
Package document in your project.   For more information, see the Bid 
Package – RFQ Processing white paper. 

 Project 
Analysis  

Use this option to open the BFA worksheet in Project Analysis mode.  
For more information, see the Focus on Forecast and Analysis and 
Focus on the BFA Workbook guides. 

 Project Setup 
Use this option to open the Project Setup document for this project.   



 Page 33 

Focus on Doc Types and Project Workflow  Project Setup 

 Change Item 
Register  

Use this option to open the Change Item Register for the project (see 
page 154). 

 

 Submittal 
Register  

Use this option to open the Submittal Item Register for the project (see 
page 90). 
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 Change Order 
Markup  

Use this option to open a list of all markups designated for Cost Code 
and Account Categories used in Change Order Budget Entries.  (For 
more information, see the Change Order Management white paper.) 
 

 

 Equipment 
Profitability 

Use this option to view the Equipment Profitability report.  It is available 
only on an Equipment project.  (For more information, see the Spitfire 
Reports technical white paper.) 
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Project Setup Info 
Overview 

The Project Setup Info document contains more information about a 
project than could be entered on the Project Setup alone.  The Project 
Setup Info document is usually customized. 

 

Where It Fits In 
The Project Setup Info document is automatically created and attached 
to a Project Setup document, when the Project Setup is first saved.  The 
Project Setup Info document, in turn, has the Project Setup as an 
attachment.   
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Opening the 
Project Setup 

Info 
You cannot create a Project Setup Info document from the Project 
Dashboard, therefore you will not find it on the Project Dashboard menu.  
If the Project Setup Info Doc type has been made site-active, a Project 
Setup Info document will be automatically attached to each Project Setup 
document. 

You can open the Project Setup Info document, as often as needed, from 
the Project Setup document. 

 

To open a Project Setup Info document: 

1. Open your Project Setup document (see page 28). 

2. Go to the Attachments tab and find the Project Setup Info 
document. 

3. Click  to open the Attachments Options menu, then select  
Open Attachment: 

 
The Project Setup Info document will open. 

4. Add information to the document, add attachments and create a 
route as appropriate. 

5. Either route the document to another person or save the 
document, then close the document window. 

6. You can reopen the document as needed to make changes to it 
and to change its status.   

Project Setup 
Info Options 

Menu 
The Options menu for the Project Setup Info document offers the 
following choices after you first save: 

  
 

TIP 
A description of all 
Document Options menu 
choices can be found on 
in the Focus on 
Document and Item 
Basics guide.  
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Statuses for 
Project Setup 

Info 
By default, the Status drop-down offers the following choices: 

 
• Closed is a final status, which closes the document.  When a 

Project Setup Info document is Closed, it can no longer be 
changed. 

Open Closed 
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Budget 
Overview 

Budget documents detail the original and current anticipated spending 
for your project through corresponding BFA workbooks.   

 
 

 

 

 

 

 

 

 

 

 

 

 

 

TIP 
For more information, 
see the Focus on 
Budgets and Period 
Distribution guide. 
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Where It Fits In 
An Initial Budget document, with a blank BFA workbook, is created when 
you first save a Project Setup document; however, any number of 
Budget revision documents (and revised BFA workbooks) can be created 
throughout your project.  You can create Budget revisions as needed.  In 
addition, several Doc types (Change Orders, CCOs, Period Distributions 
and Commitments) can also create budget revisions. 

Budget Type 
With the exception of Manual Revision, the Type field on the Document 
Header is populated automatically based on how the Budget document 
was created.  Type can indicate that the Budget document was created 
from the Project, a CCO, a Change Order, a Commitment or a Period 
Distribution.  If you create a Budget Revision document yourself 
(through ), the Type field will start out blank, but you can select the 
appropriate type of “Manual Revision”.   

 

Fiscal Period 
The Period field on the Details tab is used to indicate the fiscal period to 
which the approved budget should post.  The Period can be changed for 
budget revisions, in the format YYYYMM (for example, 201103 for March 
2011).  The current year and month appear as the fiscal period by default 
on the Initial Budget. 

 

Creating the 
Initial Budget 

A blank Initial Budget document is created automatically when you first 
save a Project Setup document.   

There are two ways to open the Initial Budget document in order to 
access the BFA workbook. 

• From a Project Setup document that has not yet been 
Committed. 

• From the Project Dashboard. 
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To open the Initial Budget from the Project Setup document: 

1. Open the Document Options menu on the Project Setup and 
select Initial Budget: 

 
The Initial Budget document will open.  You can close the Project 
Setup window. 

2. Continue with step 2 in the following instructions. 

 

To open the Initial Budget document from the Project Dashboard: 

1. Select Budget on the Documents Menu then click . 

 
2. (optional) If you want to designate a different fiscal period for the 

budget, change the Period field on the Details tab. 

3. Click  (found on the Mid-section tab line) to open Microsoft 
Excel.  An empty BFA workbook will appear. 

4. Enter data for your budget through one of the options found on 
the Budget ribbon on the worksheet. 

 
Note: if you use the Import Wizard option, you can import data 
from a file in your Spitfire Catalog. 

5. Close and save the Microsoft Excel workbook.  Back at the 
Budget document you will notice that  has changed to . 

6. Add other information to the document, add attachments and 
create a route as appropriate. 

7. Either route the document to another person or save the 
document, then close the document window. 

8. You can reopen the document as needed to make changes to it 
and to change its status.  When the Budget status is Approved, 
you will not be able to make any more changes to it. 

TIP 
For more information 
about attachments, see 
the Focus on Files, 
Attachments and the 
Catalog Dashboard 
guide.  For more 
information about routes, 
see the Focus on Routes 
guide. 

TIP 
For more information 
about budget option, see 
the Focus on Budgets 
and Period Distribution 
guide. 
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Creating Other 
Budget 

Documents 
You can create more Budget documents as needed by selecting Budget 
on the Project Dashboard Documents menu then clicking . However, 
you may have only one “open” Budget document at a time—i.e., as long 
as the document status is In Process or Pending you cannot create a 
new Budget document. Each new budget begins with a snapshot of the 
project budget to date. 

Note: the BudgetConfig | PreventNegativeEAC rule prevents approval 
of a budget revision if the revision causes a line to become negative. 

Budget Options 
Menu 

The Option menu for the Budget document offers the following choices 
after you save: 

 

Of Particular Note 
•  links to Microsoft Dynamics SL or Acumatica Cloud ERP (if 

your site is integrated with an accounting system). 

Statuses for 
Budgets 

By default, the Status drop-down offers the following choices: 

 
• Once you set the status to Approved, the budget is posted to 

Microsoft Dynamics SL, and the Budget document and 
corresponding BFA workbook become read-only. 

• Canceled and Approved are final statuses, which close the 
document. When a Budget document is Canceled or Approved, 
it can no longer be changed. 

Approved In Process 

Canceled 

Pending 

TIP 
A description of all 
Document Options menu 
choices can be found on 
in the Focus on 
Document and Item 
Basics guide.  

TIP 
A “Budget Revision 
History” report is offered 
by sfPMS.  See the 
Spitfire Reports technical 
white paper. 

TIP 
For more information 
about rules, see the 
Rules and Rule Values 
technical white paper. 
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Pay Application 
Overview 

Pay Application documents are used to create and track the SOV 
(Schedule of Values) based AR billings for your project, through the SOV 
workbook.   

 
 

 

 

 

 

 

 

 

 

 

TIP 
More information about 
the Schedule of Values 
and the SOV workbook 
can be found in the 
Focus on SOV Billing 
guide. 
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Where It Fits In 
The first Pay Application document is created from a committed Project 
Setup document.  The corresponding SOV workbook can be loaded from 
the Project Setup revenue Items, a summary of Commitments, the 
project budget or other user input.   Each subsequent Pay Application 
document is created from the previous Pay Application document, 
creating a chain. You can have any number of Pay Application 
documents. You can also have more than one Pay Application chain. 

Optional Tax 
and Retention 

Fields 
Through customization, a sales tax rate field (and corresponding tax ID 
lookup) and/or retention fields for work and materials can be included on 
your Pay Application document.  These fields are populated by the 
Project Setup document but can be overridden on the Pay Application. 
(See also page 26). 

 

Creating a Pay 
Application 

The way you create the first Pay Application is different from the way you 
create other Pay Application documents.   

Note: The Project Setup document must be Committed before you can 
create the Pay Application and SOV for the project. 

 

To create the initial Pay Application and SOV: 

1. Open your Project Setup document (see page 28). 

2. Open the Document Options menu and select  Create Pay 
Application: 

 
3. The Pay Application document will open.  The Bid document, if 

there is one, will appear as an attachment.  You can close the 
Project Setup document window. 

TIP  
See the Focus on 
System Administration 
guide for more 
information on 
customization. 
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4. (optional) Change the Description. 

5. On the Dates tab, fill out the Start and Finish Application dates. 

6. (optional) Add other information for your pay application, 
including sales tax info and retention percentages, if applicable. 

7. Click  to save the document. 

8. Click  to open the SOV workbook.  The SOV takes certain 
information from the Project Setup document including Items, if 
any.  
 
If there is a discrepancy between the sales tax rate on the Pay 
Application and the Project Setup documents, a confirmation box 
will appear, for example:  

 
o If you want to use the information from the Pay 

Application, click .   

o If you want to use information from the Project Setup 
document, click . 

o Note: if there is a sales tax ID and/or rate on only the 
Project Setup or the Pay Application, that information will 
be used in the SOV and you will not see any 
confirmation box. 

Note: If you did not enter retention percentages on your Project 
Setup document, nor on the Pay Application, the retention of 
zero is used. 

If you did enter retention percentages on the Project Setup but 
there is discrepancy between that information and the retention 
on the Pay Application, a confirmation box will appear, for 
example: 

TIP 
A confirmation box will 
also appear if the tax rate 
for a Tax ID changes in 
an integrated accounting 
system causing a 
discrepancy. 
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o If you want to use the information from the Pay 

Application, click .   

o If you want to use information from the Project 

Setup/Contract, click . 

o Note: if there is retention information on only the Project 
Setup or the Pay Application document, that information 
will be used in the SOV and you will not see any 
confirmation box. 

o Note: changes made to retention affect only new items 
in the SOV; retention on existing items (from prior Pay 
Applications) is not changed. 

9. Edit the SOV workbook, if appropriate, then close it.  When 

prompted to save, click .  After you save the 
workbook, the icon back on the SOV document will change to 

.  You can subsequently click  to access the SOV 
workbook. 

10. Add other information to the document, add attachments and 
create a route as appropriate. 

11. Either route the document to another person or save the 
document, then close the document window. 

12. You can reopen the document as needed to make changes to it 
and to change its status. 

o The SOV must include a Revenue Code and an Account 
Category for each row before it can be Invoiced. 

o When the Pay Application is Printed or Invoiced, a new 
Pay Application can be created.  

o When the Pay Application status is Completed, the 
document can no longer be edited. 

 

 

TIP 
For information about the 
SOV workbook, see the 
Focus on Schedule of 
Values (SOV) Billing 
guide. 
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To create subsequent Pay Applications: 

1. Open the current Pay Application document (provided its status 
is Printed or Invoiced). 

2. Click  to open the Document Options menu and select  
Create Pay Application: 

 
The new Pay Application document window will appear. 

Pay Application 
Options Menu 

The Option menu for the Pay Application document offers the following 
choices after you save: 

  

Of Particular Note 
•  provides information on the invoice, once it has been sent to 

your integrated accounting system (if integrated).  

•  indicates the Source Contact for the Pay Application, which 
is typically the same as the project customer. 

• After you change the Pay Application’s status to Printed or 
Invoiced, the Options menu offers an additional choice: 

 
• If you set the Pay Application status to Invoiced and the invoice 

has been posted in Microsoft Dynamics SL (integrated sites 
only), the Options menu offers a new choice: 

 

•  allows you to Reverse a posted, invoiced Pay Application. 

TIP 
A description of all 
Document Options menu 
choices can be found on 
in the Focus on 
Document and Item 
Basics guide. 
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Statuses for 
Pay 

Applications 
By default, the Status drop-down first offers the following choices: 

 
• In Process allows full editing. 

• When you set the status to Draft (and save), the SOV workbook 
and some fields of the Pay Application document become read-
only.  In addition, the Status drop-down offers new choices: 
 

 
• The document must be set to Printed or Invoiced before you 

can create another Pay Application document. 

• When the Pay Application document is Invoiced, SOV data is 
exported to Microsoft Dynamics SL Flexible Billing (if integrated).  
After the invoice is posted in Microsoft Dynamics SL, you can 
return the status to In Process by choosing the Reverse option 
from the Options menu (shown on the previous page).  
Reversing in Spitfire creates a reversal invoice in Microsoft 
Dynamics SL, which must then be posted. 

• When the status is Invoiced, the Status drop-down changes 
again: 

 
• Completed is a final status, which “closes” the document.  When 

a Pay Application document is Completed, it can no longer be 
changed. 

 

 

 

 

 

 

 

 

TIP 
If you are integrated with 
Microsoft Dynamics SL, 
you can use the 
SOVConfig | 
SOVExportToFB rule to 
enable the “Acquire 
Invoice Number” option 
on the SOV workbook.  
This option changes the 
status of the Pay 
Application to Invoiced 
and provides an Invoice 
number from Microsoft 
Dynamics SL For more 
information, see KBA-
01326 and KBA-01153 
as well as the Focus on 
Schedule of Value (SOV) 
Billing guide. 

Through Reversal 

Through SOV 
In Process 

Draft Printed 

Invoiced 

Canceled Completed 

http://clients.spitfiremanagement.com:3280/sws/kb/index.php?ToDo=view&questId=287&catId=58
http://clients.spitfiremanagement.com:3280/sws/kb/index.php?ToDo=view&questId=287&catId=58
http://clients.spitfiremanagement.com:3280/sws/kb/index.php?ToDo=view&questId=135&catId=14
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Lien Waiver 
Overview 

Lien Waiver documents largely serve as “wrappers” for routing outbound 
lien waiver files.   

 

Where It Fits In 
Lien Waivers can be created at any time and as often as necessary.   
Note: PAPTs, associated with Pay Applications, can include outbound 
lien waiver information also. 

Creating a Lien 
Waiver 

To create a Lien Waiver document: 

1. Click  at the Project Dashboard to start a new Lien Waiver 
document.  

2. (optional) Change the Description. 
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3. Click  to save (and actually create) the document. 

4. Add information to the document as appropriate. 

5. On the Attachments tab, attach one or more files to the 
document. 

o Click  to attach files from the Spitfire Catalog. 

o Click  to upload or scan files from your computer. 

6. Create a route, if necessary. 

7. Either route the document to another person or save the 
document, then close the document window. 

8. You can reopen the document as needed to make changes to it 
and to change its status. 

Lien Waiver 
Options Menu 

The Options menu for the Lien Waiver document offers the following 
choices after you first save: 

 
 

 

Statuses for 
Lien Waiver 

By default, the Status drop-down offers the following choices: 

 
• Closed is a final status, which closes the document.  When a 

Lien Waiver document is Closed, it can no longer be changed. 

 

 

TIP 
A description of all 
Document Options menu 
choices can be found on 
in the Focus on 
Document and Item 
Basics guide.  

Open Closed 

TIP 
For more information 
about attachments, see 
the Focus on Files, 
Attachments and the 
Catalog Dashboard 
guide. 
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Schedule 
Overview 

The Schedule document primarily functions as a “wrapper” for routing 
attached schedule files in Microsoft Word, Excel, or Project or created by 
another scheduling software application.   

 

Where It Fits In 
A project can have one or more Schedule documents, created as 
needed.  

Creating a 
Schedule 

Schedules are often created early in the project’s life cycle.  

 

To create a Schedule document: 

1. Click  at the Project Dashboard to start a new Schedule 
document.   

2. (optional) Change the Description. 

3. Click  to save (and actually create) the document. 

4. On the Attachments tab, attach one or more files to the 
document. 

o Click  to attach files from the Spitfire Catalog. 

o Click  to upload or scan files from your computer. 

TIP 
For more information 
about attachments, see 
the Focus on Files, 
Attachments and the 
Catalog Dashboard 
guide.  
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5. Create a route, if necessary. 

6. Either route the document to another person or save the 
document, then close the document window. 

7. You can reopen the document as needed to make changes to it 
and to change its status. 

Schedule 
Options Menu 

The Options menu for the Schedule document offers the following 
choices after you first save: 

 
 

 

Statuses for 
Schedule 

By default, the Status drop-down offers the following choices: 

 
• History is a final status, which closes the document.  When a 

Schedule document is History, it can no longer receive 
attachments. 

 

 

 

 

TIP 
A description of all 
Document Options menu 
choices can be found on 
in the Focus on 
Document and Item 
Basics guide.  

Current History 
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PunchList 
Overview  

A PunchList document is a type of “to-do” or checklist document.   

  

Where It Fits In 
Once you have a project, you can create a PunchList either manually or 
through automatic workflow.   

You can create as many PunchList documents per project as needed. 

 

 

 

 

 

Quick 
Edit 
Mode 

TIP 
For more information 
about automatic 
workflow, see the ATC 
Scripts and Automatic 
Workflow technical white 
paper. 
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Creating a 
Punch List  

PunchLists can be created at any time during the project’s life cycle. 

 

To create a PunchList document manually: 

1. Click  at the Project Dashboard to start a new PunchList 
document. 

2. (optional) Change the Description. 

3. Click  to save (and actually create) the document. 

4. On the Items tab, add your Punchlist Items.  You will be able to 
“check off” (close) the Items as needed throughout the project. 

5. Add other information to the document, add attachments and 
create a route as appropriate. 

6. Either route the document to another person or save the 
document, then close the document window. 

7. You can reopen the document as needed to make changes to it 
and to change its status to Closed.  Once Closed, the document 
becomes read-only. 

Punchlist 
Options Menu 

The Options menu for the Punch List document offers the following 
choices after you save: 

  

Of Particular Note 
•  Report opens a Spitfire Generic Print report that displays the 

Items on the document. 

Statuses for 
PunchLists 

By default, the Status drop-down offers the following choices: 

 
• Closed is a final status, which closes the document.  When a 

PunchList document is Closed, it can no longer be changed. 

 

TIP 
You can save time by 
creating a template 
punch list and then 
copying and pasting 
those Items where 
needed. See the Focus 
on Document and Item 
Basics guide for more 
information about 
copying Items. 

TIP 
A description of all 
Document Options menu 
choices can be found on 
in the Focus on 
Document and Item 
Basics guide. 

Open Closed 
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Meeting Minutes 
Overview 

Meeting Minutes documents track project meetings.   

 

Where It Fits In 
A project can have as many Meeting Minutes as needed. Meeting 
Minutes can be created manually or through automatic workflow.  One 
Meeting Minutes document can create the next Meeting Minutes 
document in a chain. 

 

 

 

 

Because the label for 
this date field is based 
upon status and is hard-
coded, it cannot be 
customized.  It is the 
DocHeader_Due  field. 

TIP 
For more information 
about automatic 
workflow, see the ATC 
Scripts and Automatic 
Workflow technical white 
paper. 
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Creating a 
Meeting 
Minutes  

Meeting Minutes can be created at any time during the project’s life 
cycle. 

 

To create a Meeting Minutes document manually: 

1. Click  at the Project Dashboard to start a new Meeting 
Minutes document (if it is the first one in a chain).   

2.  (optional) Change the Description. 

3. Click  to save (and actually create) the document. 

4. On the Attendees tab, you can add names by using any 
combination of the following: 

o Click  to look up a person and uncheck that person as 
a Regular, if appropriate.  Regular attendees will be 
carried over to the next meeting document. 

o Click  and then  to switch to “freeform” mode.  
Freeform allows you to enter any name, even names 
that are not included in your system Contacts.  Adding a 
name in this freeform name does not add the name to 
sfPMS. 

o Click  to open the multi-select window, from which you 
can select multiple people at a time. 

 
5. On the Items tab, add agenda items for the meeting: 

Note: when you save, a  icon will be added to the Item Detail 
view.  You can use that icon to add formal remarks related to the 
specific Item.  Both remarks and notes remain with the Item if the 
Item is carried over to another Meeting Minutes document. 

6. Add other information to the document, add attachments and 
create a route as appropriate. 

7. Either route the document to another person or save the 
document, then close the document window. 

TIP 
For more information 
about the Items tab, see 
the Focus on Document 
and Item Basics guide.  
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8. You can reopen the document as needed to make changes to it 
and to change its status to Meeting Completed when 
appropriate (see the next section). 

 

To create a “chain” of Meeting Minutes: 

1. Once you have had your meeting, open the Meeting Minutes 
document. 

2. On the Attendees tab, edit each row to indicate who actually was 
Present at the meeting.  You can also add attendees: 

3. On the Items tab, edit Item Descriptions if appropriate. 

4. On the Items tab, change the status of each Item that was 
resolved to Closed.  Such items will not be carried over to the 
next meeting.  Items with a status of Open will be carried over 
and given a new status of Carried Over. 

5. On the Document Header, change the status of the document to 

Meeting Completed.  A  button will appear 
on the Details tab. 

 

6. Click the  button.  A new Meeting Minutes 
document window will appear, with open items and attachments 
from the first meeting carried over.  You can close the first 
Meeting Minutes document window. 

7. Add information about the next meeting, save and close.  After 
this second meeting, you can create a document for the third 
meeting, fourth meeting and so on using these same steps.  
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Meeting 
Minutes 

Options Menu 
The Options menu for the Meeting Minute document offers the following 
choices after you save: 

 
 

 

Statuses for 
Meeting 
Minutes 

By default, the Status drop-down for Meeting Minutes offers the following 
options: 

 
• In order to create a new Meeting Minutes from a previous 

Meeting Minutes document, the status of the previous document 
must be set to Meeting Completed.  A Meeting Completed 
status still allows editing, however. 

• Closed is a final status, which closes the document.  When a 
Meeting Minute document is Closed, it can no longer be 
changed. 

 

 

 

 

 

 

Agenda 

Meeting 
Completed 

Closed 

TIP 
A description of all 
Document Options menu 
choices can be found on 
in the Focus on 
Document and Item 
Basics guide. 
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Permits 
Overview 

A Permits document tracks the permits associated with your project.   

 

Where It Fits In 
A project can have as many Permits documents as needed. 

Creating a 
Permit 

Permits can be created at any time during the project’s life cycle. 

 

To create a Permits document: 

1. Click  at the Project Dashboard to start a new Permits 
document.   

2. (optional) Change the Description. 

3. Click  to save (and actually create) the document. 
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4. On the Items tab, add your Permits Items.  You may need to 
select your specific Item from a Specific Permit drop-down.  

 
5. Add other information to the document, add attachments and 

create a route as appropriate. 

6. Either route the document to another person or save the 
document, then close the document window. 

7. You can reopen the document as needed to make changes to it 
and to change its status to Closed.  Once Closed, the document 
becomes read-only. 

Permits 
Options Menu 

The Options menu for the Permits document offers the following choices 
after you first save: 

 
 

 

Statuses for 
Permits 

By default, the Status drop-down offers the following choices: 

 
• Closed is a final status, which closes the document.  When a 

Permits document is Closed, it can no longer be changed. 

 

 

 

 

TIP 
A description of all 
Document Options menu 
choices can be found on 
in the Focus on 
Document and Item 
Basics guide.  

Open Closed 

TIP 
For more information 
about the Items tab, see 
the Focus on Document 
and Item Basics guide.  
For more information 
about attachments, see 
the Focus on Files, 
Attachments and the 
Catalog Dashboard 
guide.  For more 
information about routes, 
see the Focus on Routes 
guide. 
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Drawings 
Overview  

A Drawings document tracks and identifies drawing files.  Drawing files 
that are attached to one Drawings document serve as a drawing log for 
the project.     

 

Where It Fits In 
A project can have any number of Drawings documents, often grouped 
by subtype. Other Doc types (such as Commitments or Bid Packages) 
can attach the files that are attached to a Drawings document through 
the  icon on their Attachments tab. 
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Creating a 
Drawings 

Document  
Drawings documents can be created at any time during the project’s life 
cycle. 

 

To create a Drawings document: 

1. Click  at the Project Dashboard to start a new Drawings 
document.   

2. (optional) Change the Description. 

3.  (optional) Look up a Responsible person. 

4. (optional) Select a drawings Type from the drop-down. 

5. Click  to save (and actually create) the document. 

6. On the Attachments tab, attach one or more files to the 
document. 

o Click  to attach files from the Spitfire Catalog. 

o Click  to upload or scan files from your computer. 

7. Add other information to the document and create a route as 
appropriate. 

8. Either route the document to another person or save the 
document, then close the document window. 

9. You can reopen the document as needed to make changes to it 
and to change its status to Published or Closed.  By default, 
Published is a pending status that allows the Drawings document 
to be seen on the Plan Room Dashboard.  Once Closed, the 
document cannot be changed in any way. 

Drawings 
Documents on 
the Plan Room 

Drawings is a Doc type that is often included on the Plan Room 
Dashboard. For more information about the Plan Room setup and use 
see 

• The Setup for Spitfire’s Plan Room technical white paper 

• The How to Use the Plan Room (from a public login) instructions 

• The How to Use the Plan Room (from a vendor login) 
instructions 

 

 

 

 

TIP 
For more information 
about attachments, see 
the Focus on Files, 
Attachments and the 
Catalog Dashboard 
guide. 



 Page 62 

Focus on Doc Types and Project Workflow  Drawings 

Drawings 
Options Menu 

The Options menu for the Drawings document offers the following 
choices after you save: 

 
 

 

Statuses for 
Drawings 

By default, the Status drop-down offers the following choices: 

 
• Published is a pending status, which allows the document to 

appear in the Plan Room Dashboard. 

• Closed is a final status, which “closes” the document.  When a 
Drawings document is Closed, it can no longer be changed.

TIP 
A description of all 
Document Options menu 
choices can be found on 
in the Focus on 
Document and Item 
Basics guide. 

Published 

In Process 

Closed 
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Invitation to Bid 
Overview 

Invitation to Bid documents are used to send general information about a 
project to a large number of potential vendors. 

 

Where It Fits In 
Invitation to Bid documents usually fit into one of two workflows: 

• The Invitation to Bid document (through an Attachment or 
Transmittal template printout) and its attached files are routed via 
email, fax or hard copy to a number of vendors, 

• The Invitation to Bid document is placed on the Plan Room 
Dashboard and vendors are given the login ID and password 
necessary to access it and any other related documents, such as 
Drawings. 
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Creating an 
Invitation to Bid 

Invitation to Bid documents can be created at any time during the 
project’s life cycle. 

There are two ways to create an Invitation to Bid: 

• From the File menu—use this method if you are not yet working 
on a project. 

• From the Project Dashboard—use this method if you are already 
working on a project. 

 

To create an Invitation to Bid from the Site Options menu: 

1. Select Create Document: 

 
2. Select Invitation to Bid. An Invitation to Bid document window 

will open. 

3. Continue with step 2 in the following instructions. 

 

To create an Invitation to Bid from a Project Dashboard: 

1. Click  at the Project Dashboard to start a new Invitation to Bid 
document.   

2.  (optional) Change the Description. 

3. Change the Due Date to reflect by when all bids must be 
received. 

4. (optional) On the Addr tab, look up the Respond To whom the 
potential vendors will respond.  

5. Click  to save (and actually create) the document. 

6. (optional) Add attachments if appropriate. 

7. (optional) If the document has a merge template that will use the 
Notes on the document, enter information about your project on 
the Notes tab.  
Note: Invitation to Bids that will be emailed or faxed to vendors 
use templates (an Attachment and/or a Transmittal template) to 
create printouts of the document.  

8. (If you will route the document) On the Route Details tab, click 
 to open the Options menu, then select the  Build Route 

option. 
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The Build Route window will open. 

o Click  to select your vendors. 

 
o Use the filters to select the vendors to receive the 

Invitation to Bid.  

o Back on the Build Route dialog box, lookup a Role, if 
one has been set up to identify Contacts on your vendor 
companies, for example: 

 
Note: the With Transmittal option is checked by default.  
Click the checkbox to uncheck it if you do not want 
transmittals for all your vendors. 

o Click . 
 

TIP 
For more information 
about the Build Route 
option, see the Focus on 
Routes guide. 
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9. When appropriate, change the status of the document to 
Published.  By default, Published is a pending status that allows 
the Invitation to Bid document to be seen on the Plan Room 
Dashboard (see the next page). 

10. Either route the document to all your vendors or save the 
document, then close the document window. 

11. You can reopen the document as needed to make changes to it 
and to change its status.  Once the document is Closed, no 
further changes can be made to it.  

Replies from 
Vendors 

Once you hear back from your vendors, you can choose to create  RFQs 
(see page 68) or a Bid Package depending on your workflow.  In fact, 
you can easily attach the Invitation to Bid to the Bid Package and easily 
create RFQs on the Bid Package for the vendors who respond in the 
affirmative to the Invitation to Bid (see page 73). 

 

To record affirmative responses: 

1. On the Route Detail tab, edit the row for a vendor who has 
responded in the affirmative to the Invitation to Bid. 

2. Select the affirmative Rsp from the drop-down. 

 
3. Click  to accept the Rsp and advance the route.  

Note: it is also possible that a vendor will respond to an emailed 
Invitation to Bid directly, either by replying to the email or using the 
Response Wizard.  (For more information, see the Focus on Routes 
guide.)  

Invitation to Bid 
Documents on 
the Plan Room 

Invitation to Bid is a Doc type that is often included on the Plan Room 
Dashboard. For more information about the Plan Room setup and use 
see 

• The Setup for Spitfire’s Plan Room technical white paper 

• The How to Use the Plan Room (from a public login) instructions 

• The How to Use the Plan Room (from a vendor login) 
instructions 
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Invitation to Bid 
Options Menu 

The Options Menu for the Invitation to Bid document offers the following 
choices after you save: 

 
 

Statuses for 
Invitation to Bid 

By default, the Status drop-down offers the following choices: 

 
 

• Published is a (default) pending status, which allows the 
Invitation to Bid document to appear on the Plan Room 
Dashboard. 

• Canceled and Closed are final statuses, which close the 
document.  When an Invitation to Bid document is Closed or 
Canceled, it can no longer be edited. 

 

 

 

 

 

TIP 
A description of all 
Document Options menu 
choices can be found on 
in the Focus on 
Document and Item 
Basics guide. 

Closed 

Canceled 

In Process 

Open 

Published 
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RFQ 
Overview 

An RFQ (Request for Quote) document tracks your quote request to a 
subcontractor/vendor and his response (quote/bid).  : 
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Where It Fits In 
RFQs can be part of larger workflows, such as when RFQs are created 
from a Bid Package document and the awarded RFQ leads to a 
Commitment, or when a Change Order creates RFQs for those 
Commitments affected by the project change.  However, you can also 
create stand-alone RFQs as needed whenever you want to record a 
quote from a vendor.  RFQs can lead to either Commitments or CCOs. 

Creating an 
RFQ 

There are three ways to create an RFQ document: 

• From the Project Dashboard— use this method whenever you 
want a stand-alone quote that is not related to any Bid Package 
or Change Order document.  The RFQ can lead to either a new 
Commitment or a CCO for an existing Commitment.  (See 
below.) 

• From a Bid Package document—use this method whenever the 
RFQ corresponds to the Bid Package document.  Note: A Bid 
Package document can contain any number of RFQs. 
(See the Bid Package – RFQ Processing white paper.) 

• From a Change Order document—use this method whenever the 
RFQ is part of your Change Order workflow.  (See the Change 
Order Management white paper.) 

 

To create an RFQ from the Project Dashboard: 

1. Click  at the Project Dashboard to start a new RFQ document. 

2. (optional) Change the Description to something more 
descriptive of the RFQ or eventual Commitment or CCO. 

3. Look up a Vendor. 

4. (optional) Select a Commitment Type (subtype) and/or a 
Contract Type. 

5. (optional) Look up or fill in other fields in the Document Header. 

6. Click  to save (and actually create) the document. 

7. (optional) If this RFQ will lead to a CCO, go to the Details tab 
and look up the Commitment that will require a change. 

 
8. (optional) On the Addr tab, look up a specific person at the 

Vendor company, especially if you will use the Build Route 
option to add this vendor to your route: 



 Page 70 

Focus on Doc Types and Project Workflow  RFQ 

 

 
9. Go to the Items tab and add your Item(s).   

10. Add other information to the document and add attachments as 
appropriate. 

11. (optional) Add the vendor as a routee, unless an automated 
route has already done so.   

12. (optional) If an Attachment template has been established for 
this Doc type,  will appear on the Attachments tab.  Click on 

 to create the printout file for the RFQ.  This printout file will be 
emailed or faxed to potential customers who are set up as “via 
email” or “via fax” routees (along with other attached files). 

13. Either route the document or save the document, then close the 
document window. 

14. You can reopen the document as needed to make changes to it 
and to change its status.   

Updating an 
RFQ 

To enter amounts from a returned Bid/Quote: 

1. Open the RFQ document from the Project Dashboard or your 
Inbox. 

2. (optional) If you do not want to continue with this RFQ, change 
its status to Rejected and save the document.  Otherwise, 
continue with the next step. 

3. On the Document Header, look up the Vendor Submitter (i.e., 
the person who submitted the quote/bid). 

4. Edit the Items on the Items tab to enter bid information. 

5. Change the document status to Bid Back. 

6. (optional) Click   to route the document if appropriate. 

7. Close the document. 

TIP 
For more information 
about the Items tab, see 
the Focus on Document 
and Item Basics guide.  
 
For more information 
about attachments, see 
the Focus on Files, 
Attachments and the 
Catalog Dashboard 
guide.   
 
For more information 
about routes, see the 
Focus on Routes guide. 
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Awarding an 
RFQ 

Before you can create a Commitment or a CCO from an RFQ, the RFQ’s 
status must be Awarded. 

 

To Award the RFQ document: 

1. Open the RFQ document if not already open. 

2. (If necessary) Look up a Vendor Submitter (the person/vendor 
on record who has approved the quote). 

3. Change the status of the document to Awarded.   

4. Save the document. You can now create the Commitment or 
CCO document from the Options menu (as described in the next 
section).  

RFQ Options 
Menu 

The Options menu for the RFQ document offers the following choices 
after you save: 

 

Of Particular Note 
• The option to  Open Change Order appears only if you 

created the RFQ from a Change Order document.   

• The option for   Related Documents appears only if the RFQ 
is linked to a Commitment. 

•  indicates the Vendor who is bidding.  This option appears 
only after you look up a choice for the Vendor field. 

• Once you set the RFQ status to Awarded (and save), the 
Options menu offers a new choice: 

  
- or-  

TIP 
A description of all 
Document Options menu 
choices can be found on 
in the Focus on 
Document and Item 
Basics guide. 

TIP 
If you try to create a 
Commitment or CCO 
from an RFQ that was, in 
turn, created from a 
Change Order, a 
confirmation message 
will inform you of the fact.  
Unless you have special 
permission, you must 
create the Commitment 
or CCO through the 
Change Order in such a 
situation.  For more 
information, see the 
Change Order 
Management white 
paper. 



 Page 72 

Focus on Doc Types and Project Workflow  RFQ 

 

 

o The choice to  Create Commitment will create a 
Commitment document based on the RFQ.  (See page 
83 for more information about Commitments.) 

o The choice to  Create CCO will create a CCO 
document based on the RFQ, if the RFQ was linked to 
an existing Commitment.  (See page 116 for more 
information about CCOs.)   

Statuses for 
RFQs 

By default, the Status drop-down offers the following choices: 

 
• The status must be set to Awarded before you can create 

Commitments/CCOs. 

• Canceled and Awarded are final statuses, which close the 
document.  When an RFQ document is Awarded or Canceled, it 
can no longer be edited. 

•  

 

 

 

 

 

 

 

 

Awarded 

Canceled 

In Process 

Bid Back 

Out for Bid 

Canceled 

Declined to Bid 

Rejected 
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Bid Package 
Overview 

When the same RFQ is sent to more than one vendor, a Bid Package 
document is used to contain information about the quote request and all 
responses from the subcontractors/vendors receiving the RFQ.   

 
 

 

TIP 
For more information see 
the Bid Package – RFQ 
Processing white paper  
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Where It Fits In 
Bid Packages create corresponding RFQs, therefore, the Bid Package 
document is often used to start a Bid Package – RFQ – Commitment 
workflow.  Bid Packages can be created during the early stages of a 
project (if you need quotes from vendors before you can submit your own 
bid) or at any time during a project’s life cycle.  Pending Bid Packages 
can appear on the Plan Room Dashboard.  Bid Packages can also 
create Bid Package Addendums. 

Attached 
Invitation to Bid 

If your workflow starts with an Invitation to Bid, you can attach the 
corresponding Invitation to Bid to the Bid Package document (see the 
instructions that start on page 76).   

 
Once the Invitation to Bid document is attached to the Bid Package, and 
once vendors have responded to the Invitation to Bid, a new icon 
appears on the RFQ tab that allows you to create RFQs for the vendors 
who have responded in the affirmative to the Invitation to Bid (see the 
next section). 

The RFQs Tab 
The Bid Package document includes an RFQs tab.  The RFQs tab allows 
you to quickly create as many RFQ documents as needed for your 
vendors and then route them.  The RFQ tab also maintains the list of 
these RFQ documents, their amounts and their statuses.  As information 
(Amount and Status) is changed on the RFQs, this information is 
updated on the Bid Package on its next refresh. 

 
 

 

TIP 
Once you create an RFQ, 
any new items added to 
the Bid Package will not 
be copied.  Make sure 
your Bid Package is 
complete before creating 
RFQs. 

You can release 
(send) all RFQ 
documents on their 
routes with one click. 

With one click, you can 
automatically select those 
vendors who accepted 
the Invitation to Bid. 

You canuse a multi-select 
window  to select vendors.  
sfPMS will create an RFQ 
document for each.  
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Bid Package 
Documents on 
the Plan Room 

Bid Package is a Doc type that can be included on the Plan Room 
Dashboard.  When a vendor opens the Bid Package from the Plan 
Room, he can create an RFQ (in order to enter his bid/quote) by clicking 
a link on the Instructions/Notes tab (shown below).  

For more information about the Plan Room setup and use see 

• The Setup for Spitfire’s Plan Room technical white paper 

• The How to Use the Plan Room (from a public login) instructions 

• The How to Use the Plan Room (from a vendor login) 
instructions 

 
Note: the RFQs tab on the Bid Package is hidden for vendors. 
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Creating a Bid 
Package 

There are four ways to create a Bid Package document: 

• From a Bid document—use this method when you are 
requesting quotes for a prospective project (see page 21.) 

• From automatic workflow from an Invitation to Bid—use this 
method when your Invitation to Bids always result in Bid 
Packages. 

• From the File menu—use this method when you want to create a 
Bid Package before you create a project. 

• From a Project Dashboard—use this method when the Bid 
Package is your starting document in the Bid Package – RFQ – 
Commitment workflow.  

 

To create a Bid Package document from the Site Options Menu: 

1. Select Create Document: 

 
2. Select Bid Package. 

 
An Invitation to Bid document window will open.  Continue with 
step 2 in the following instructions.  

 
To create a Bid Package document from the Project Dashboard: 

1. Click  at the Project Dashboard to start a new Bid Package 
document.   

2. (optional) Change the Description. 

3. (optional) Select a Type (subtype) to indicate the type of 
subcontract that will result from the winning bid.  This Type will 
be passed to the eventual Commitment. 

4. (optional) Select a Contract Type for the Commitment that will 
result from the winning bid. 

5. (optional) Look up or fill in other fields in the Document Header, 
for example the Due date. 

6. Click  to save (and actually create) the document. 

7. On the Instructions tab, type your instructions to vendors.  

TIP 
See the ATC Scripts and 
Automatic Workflow 
technical white paper for 
more information about 
script-based workflows 
and KBA-01468 for a 
specific example. 

http://clients.spitfiremanagement.com:3280/sws/kb/index.php?ToDo=view&questId=425&catId=60
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8. On the Items tab, add Items for the Bid Package.  These Items 
will be copied to the RFQ documents that you will create.  On 
each Item’s Detail view, 

o Be sure the Include checkbox is checked if you want the 
Item to be included in the final calculation summarized 
on the Detail tab.   

o Look up a Cost Code. 

o Look up an Acct Category. 

o (optional) Enter a Description if you do not want the one 
that defaults from the Cost Code. 

o (optional) Enter Units.   

o Fill out other fields as needed. 

9. (optional) Add information to other tabs, as appropriate, for 
example, inclusions and exclusions.  This information will 
eventually be copied to a Commitment, if the Commitment is 
created from an Awarded RFQ from the Bid Package. 

10. (optional) If an Attachment template has been established for 
this Doc type,  will appear on the Attachments tab.  Click on 

 to create the printout file for the Bid Package.  This printout 
file will be emailed or faxed to potential customers who are set 
up as “via email” or “via fax” routees (along with other attached 
files). 

11. (optional) Attach any files that you want routed with the RFQs to 
your Vendors.  Files that are attached to the Bid Package will 
automatically be attached to its RFQs. 

12. (optional) If this Bid Package is part of an Invitation to Bid – Bid 
Package workflow, click  on the Attachments tab to attach 
the corresponding Invitation to Bid to this Bid Package 
(see page 74). 

13. On the RFQs tab, you can create RFQs by using any 
combination of the following: 

o Click  to create one RFQ document.  The RFQ 
document will open so that you can fill it out and save it.  
This method requires you to select a vendor on the RFQ. 

o Click  to select your vendors from the multi-select 
window. When you click  sfPMS will create an RFQ 
document for each vendor. 

o Click   to have sfPMS automatically select the 
vendors that replied in the affirmative on an attached 
Invitation to Bid (see page 66). When you click sfPMS 
will create an RFQ document for each vendor. 

14. Click  to route the RFQs to their next routees. 

15. Save the document, then close the document window. 

16. You can reopen the document as needed to review the RFQs 
tab and to change its status. 

TIP 
For information on 
attaching files to a 
document, see the Focus 
on Files, Attachments 
and the Catalog 
Dashboard guide. 

TIP 
For more information 
about the RFQs tab, see 
the Bid Package – RFQ 
Processing white paper  

TIP 
After clicking , you 
can click  to add 
other vendors if you wish.  
In addition, if other 
affirmative responses are 
added to the Invitation to 
Bid, you can resuse  
to add those vendors.  
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Bid Package 
Options Menu 

The Options Menu for the Bid Package document offers the following 
choices after you save: 

 

Of Particular Note 
• After you change the Bid Package’s status to Accepting Bids or 

Bidding Closed, the Options menu offers the choice to create a 
Bid Package Addendum document (see page 79).   

 

Statuses for Bid 
Packages 

By default, the Status drop-down offers the following choices: 

 
• Accepting Bids is a pending status, which allows the Bid 

Package to appear on the Plan Room Dashboard.  Bidding 
Closed is also a pending status.  When the document is 
pending, its status can return to In Process if changes are 
required.  

• Closed is a final status, which “closes” the document.  When a 
Bid Package document is Closed, it can no longer be changed. 

 

 

 

 

 
Accepting Bids Bidding Closed 

Closed In Process 

TIP 
A description of all 
Document Options menu 
choices can be found on 
in the Focus on 
Document and Item 
Basics guide 
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Bid Package Addendum 
Overview  

A Bid Package Addendum document is used to add information to an 
existing Bid Package that was sent out to vendors.   

 

Where It Fits In 
Bid Package Addendums update or add information to Bid Packages. A 
Bid Package Addendum can appear on a Plan Room Dashboard or be 
routed to vendors as needed.  You can create multiple Bid Package 
Addendum documents during the life cycle of a project. 
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Bid Package 
Addendum 

Documents on 
the Plan Room 

Bid Package Addendum is a Doc type that can be included on the Plan 
Room Dashboard.   

For more information about the Plan Room setup and use see 

• The Setup for Spitfire’s Plan Room technical white paper 

• The How to Use the Plan Room (from a public login) instructions 

• The How to Use the Plan Room (from a vendor login) 
instructions 

Creating a Bid 
Package 

Addendum 
There are two ways to create a Bid Package Addendum document: 

• Manually, with no automatic connection to a Bid Package. 

• From a Bid Package document with a status of Accepting Bids. 

 

To create a Bid Package Addendum from a Bid Package: 

1. Open the Bid Package.   

2. Open the Document Options menu and select Create Bid 
Package Addendum: 

 

3. Click  at the confirmation box that appears. 
A Bid Package Addendum document will open.  You can close 
the Bid Package window. 

4. Notice that the Instructions, Design Changes and Spec Changes 
fields on the Notes tab have been filled in with the Instructions, 
Submit To and Changes fields from the Bid Package.  Edit as 
necessary; you can cut and paste. 

5. Continue with step 5 in the following instructions. 
Note: The Bid Package document will already be attached. 
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To create a Bid Package Addendum manually: 

1. Click  on the Project Dashboard to start a new Bid Package 
Addendum document.   

2. (optional) Change the Description. 

3. Click  to save (and actually create) the document. 

4. On the Notes tab, enter your instructions, design changes and/or 
spec changes. 

5. Add attachments as appropriate.  You can attach a Bid Package 
document also if desired. 

6. (optional) Build a route to appropriate vendors, if the Bid 
Package Addendum will not be placed in the Plan Room. 

7. Save ( ) the document. 

8. When the document is ready for your vendors, change the status 
to Published.  By default, this pending status allows the Bid 
Package Addendum to appear on the Plan Room Dashboard. 

9. Either send the document on its route or save the document. 

10. Close the document window. 

Bid Package 
Addendum 

Options Menu 
The Options menu for the Bid Package Addendum document offers the 
following choices after you save: 

 
 

 

 

 

 

 

 

 

 

 

 

 

TIP 
A description of all 
Document Options menu 
choices can be found on 
in the Focus on 
Document and Item 
Basics guide. 
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Statuses for Bid 
Package 

Addendums 
By default, the Status drop-down offers the following choices: 

 
• Published is a default pending status, which makes the Bid 

Package Addendum read-only and allows it to be included in the 
Plan Room Dashboard.  Published documents can go back to In 
Process if changes are necessary. 

• Closed is a final status, which closes the document.  When a Bid 
Package Addendum document is Closed, it can no longer be 
changed in any way. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Closed 

In Process 

Published 
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Commitment 
Overview 

The Commitment document contains information on the contracts you 
have with vendors and subcontractors (subcontracts) and, optionally, 
suppliers (purchase orders).   

 

Where It Fits In 
A project can have any number of Commitments of different subtypes.  
Commitments can be created from RFQs when they are part of a (Bid 
Package) – RFQ – Commitment workflow and they can also be created 
from Change Orders.  Compliance tracking is tightly intertwined with 
Commitments.  Once Committed (approved), Commitments require CCO 
documents for any changes made to the Commitment Items.  
Commitments can update the budget.  Commitments are also linked to 
Pay Requests and, optionally, Receipts. 

When used at non-
integrated sites, this 
checkbox is purely 
informational.   
 
However, when used 
at integrated sites, 
checking the Owner 
Direct checkbox will 
prevent the 
Commitment (and its 
associated Pay 
Requests) from being 
exported to the 
accounting system. 

You can easily attach 
files that are on a 
Drawings Log to your 
Commitment. 
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Compliance 
Tab 

By default, the Commitment Doc type includes the Compliance tab, 
where compliance requirements are tracked for the specific Commitment 
against the Commitment’s Start and Finish dates, Commitment amount 
and percent paid. 

 

Pay Status 
The Pay Status field informs you of compliance issues.  You cannot edit 
this field. 

 
• If the Commitment is in-compliance, the message will say In 

compliance.  

• If the Commitment is out of compliance, the message will say n 
compliance issues.  This message can be changed only by 
entering compliance information under the Compliance tab. 

• If the Vendor is out of compliance, the message will say n 
vendor issues.  This message can be changed only by entering 
compliance information under the Compliance tab of the Vendor 
document. 

 
 
 
 
 
 

TIP 
For more information 
about Compliance and its 
setup, see the Focus on 
Alerts and Compliance 
guide. 
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Optional Tax/ 
Freight 

Handling 
Commitment documents can be configured to track how remitted sales 
tax is handled.  The Tax Handling drop-down on the Details tab indicates 
a default, which you can override.   

 
• No Tax means that tax is not tracked on the Commitment. 

• Tax Included means that the Item amounts include tax. 

• Tax Added means that separate Items will be added for tax (see 
below). 

Commitment documents can also be configured to allow Items just for 
freight.   

 

To add separate freight and/or tax lines: 

• To add an Item for tax, select the Add Tax Line option from the 
Items Options menu: 

 
Note: you must have at least one Item on the document before 
adding the tax line. 

• To add an Item for freight, select the Add Freight option from 
the Items Options menu: 

 
 
 
 
 
 
 
 
 

TIP 
The tax line and freight 
options will not appear 
unless the site has been 
implemented with the 
WBAConfig rule.  See 
KBA-01395,. “Tracking 
Freight and Remitted 
Sales Tax on 
Commitments.” 

TIP 
Remitted Sales Tax is 
part of the commitment 
expense like labor and 
materials.  You may 
prefer to track the 
remitted tax portion of the 
expense explicitly 
because doing so makes 
it easier to offset Use Tax 
liabilities later in the 
project. 

http://clients.spitfiremanagement.com:3280/sws/kb/index.php?ToDo=view&questId=356&catId=40
http://clients.spitfiremanagement.com:3280/sws/kb/index.php?ToDo=view&questId=356&catId=40
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Creating a 
Commitment 

There are three ways to create a Commitment document: 

• From the Project Dashboard—use this method for a stand-alone 
Commitment (see the next page). 

• From an RFQ document—use this method when you want the 
Commitment to be based on an Awarded RFQ (see page 71).   

• From a Change Order document—use this method when the 
Commitment is part of a Change Order workflow.  (See the 
Change Order Management white paper.) 

 

To create a Commitment from the Project Dashboard: 

1. Click  on the Project Dashboard to start a new Commitment 
document.   

2. Change the Description to something more descriptive of the 
commitment/subcontract.   
Note: You might be able to type the beginning of a CSI code 
(and press Enter) to have the field filled in automatically, if CSI 
codes have been set up with Descriptions in the CSI 
Maintenance tool. 

3. Look up a Vendor.  You cannot set the status to Committed 
without a Vendor. 

4. Select a Commitment Type (which is a document subtype) and 
a Contract Type. 

5. Look up or fill in other fields in the Document Header.  Use the 
Date field to indicate that execution date of the subcontract and 
the Due date for internal routing and alert purposes. 

6. Click  to save (and actually create) the document. 

7. (optional) Enter a Retention amount at the Details tab. 
Note: you can also enter a retention percentage on each 
individual Item. 

8. (optional) Select a Tax Handling choice (see page 85). 

9. On the Dates tab, edit Start and Finish Dates for the 
Commitment.  The Project Contract Start and Finish dates 
appear by default: 

 
o You can also add other dates. 

 

TIP 
If you enter a Unit of 0 or 
1 for your Item and the 
UOM is blank or LS 
(lump sum), sfPMS will 
blank out the quantity. 
A Unit of 1 and a UOM 
other than LS will be 
retained as entered. 
 
For more information 
about the Items tab, see 
the Focus on Document 
and Item Basics guide. 

TIP 
For more information 
about the CSI 
Maintenance tool, see 
the Focus on System 
Administration guide. 
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10. Go to the Items tab and add your Item(s).    

o (If your site is integrated) Each item should have a Cost 
Code, Account Category and GL Account.  You will 
not be able to change the status of the document to 
Committed without this information.  Look up the fields 
necessary. 

o (optional) Add a dedicated Tax Line and/or Freight Item 
if appropriate (see page 85). 

11. Check the Compliance tab to see if you need to enter 
compliance information. 

o  indicates that the status of this compliance line item 
is still unknown.  Click  to enter information for each 
compliance item. 

12. (optional) Add information to other tabs, as appropriate. 

13. Add attachments if desired and create a route if necessary. 

14. (optional) If an Attachment template has been established for 
this Doc type,  will appear on the Attachments tab.  Click on 

 to create the printout file for the Commitment.  This printout 
file will be emailed or faxed to potential customers who are set 
up as “via email” or “via fax” routees (along with other attached 
files). 

15. Either route the document to another person or save the 
document, then close the document window. 

16. You can reopen the document as needed to make changes to it 
and to change its status. 

o Change the status to Pending and then Committed if 
and when appropriate.  Once the Commitment is 
Committed, changes to Items are made through CCOs. 

TIP 
For information about 
attachments, see the 
Focus on Files, 
Attachments and the 
Catalog Dashboard.  For 
information about routing 
documents, see the 
Focus on Routes  guide. 
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Commitment 
Options Menu 

The Options menu for the Commitment document offers the following 
choices when you save:  

 

Of Particular Note 
•  The information note at the bottom of the Option menu will tell 

you if the Vendor is out of compliance. 

• After you have Change Orders associated with this Commitment, 
the  Change Order Log option opens the “Spitfire CCO Log”. 

• The  Commitment-vs-Budget option opens the “Commitment 
Budget Comparison” report. 

• If you are set up for Compliance tracking, the  Compliance 
option opens the “Compliance Exception Log”. 

• After you have Pay Requests associated with this Commitment, 
the  Pay Request Log option opens the “Spitfire Pay Request 
Log”. 

• If you have approved Pay Requests for this Commitment, the 
Payment Detail option will open the “Payment Detail” report, 
which lists information about the checks used to pay the 
Commitment. 

Statuses for 
Commitments 

At first, the Status drop-down offers the following choices: 

 

TIP 
A description of all 
Document Options menu 
choices can be found on 
in the Focus on 
Document and Item 
Basics guide. 

TIP 
“Commitment Log” and 
“Commitment By Cost 
Code” reports are also 
offered by sfPMS.  See 
the Spitfire Reports 
technical white paper for 
a description of all 
reports. 
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• Once you enter information and save the document, the Status 
drop-down offers new choices:  

 
• Use Pending or Requisition to indicate that the Commitment is 

ready for consideration or approval. 

• If the status is set to Committed, the Commitment document, 
when integrated, appears in Microsoft Dynamics SL (Contract 
Management Module).   

• The Commitment must be Committed before you can create 
CCOs.  In addition, the Status drop-down offers a new choice: 
 

 
• Canceled and Completed are final statuses, which “close” the 

document.  When a Commitment is Canceled or Completed, it 
can no longer be changed. 

 

 

 

 

 

In Process 

Pending 

Canceled 

Committed Completed 

Requisition 
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Submittal, Submittal Package, Submittal Item Register 
Overview 

Submittals, Submittal Packages and the Submittal Item Register are 
inter-related documents on a project. Submittals list and send details of a 
project, especially materials and documentation, to subcontractors or 
vendors.  Submittal Packages list and send the materials and 
documentation to clients or architects.  The Submittal Item Register 
tracks all Submittal Items for the project.   
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Where They Fit 
In 

You can start the Submittal process with the Submittal, Submittal Item 
Register or (less often) the Submittal Package document.  Every 
Submittal Item entered on a Submittal or Submittal Package also 
appears on the Submittal Item Register.  Therefore, the Submittal 
Register is the master list of all Submittal Items with links to all 
corresponding Submittals and Submittal Packages.  Each Submittal Item 
is its own entity with its own Item number and status. When you update a 
Submittal Item, the update is immediately displayed on the Submittal 
Item Register and on any Submittal/Submittal Package on which it 
appears.  

You can create a Submittal Package from a Submittal and you can 
create a Submittal from a Submittal Package.  The project’s only 
Submittal Item Register, however, is created automatically when the 
Project Setup document on a new project is first saved. 

The Submittal 
Icons 

In the Item grid view of Submittals, Submittal Packages and Submittal 
Item Registers, the two columns of icons indicate the same thing.  The 
first column indicates the status of the Submittal.  The second column 
indicates the status of the Submittal Package. 

 means the Item is not on a Submittal/Submittal Package. 

 means the Item is on a  Submittal/Submittal Package that is Closed.        

 means the Item is on a Submittal/ Submittal Package that is Open. 

Clicking the icon will indicate the actual Submittal/Submittal Package 
document that contains the Item.  You can click on document name to 
open the document. 
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Submittal Item 
Dates 

Submittal Items can include up to six dates fields.  While it is possible to 
hide, re-label or repurpose any of these fields, the date fields were 
designed as follows. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Requested – can indicate when a Submittal Item is added to a 
Submittal.  You can enter any date you want in this field. 

Received – can indicate when the Submittal Item is received from the 
subcontractor/vendor.  You can enter any date you want in this field. 

Submitted – can indicate when the Submittal Item is added to a 
Submittal Package or when it is routed to the client/architect.  You can 
enter any date you want in this field. 

Reviewed – indicates when the Submittal Item was reviewed.  This date 
is populated automatically by Spitfire whenever the Item Status changes, 
although you can override the date.  Note: if you override the date, it will 
no longer auto-populate when the status next changes. 

Due – can indicate when the Submittal Item is due to be received.  You 
can enter any date you want in this field. 

Completed – can indicate when consideration of the Submittal Item is 
over.  You can enter any date you want in this field. 

Possible 
Workflow 

1. Enter your Submittal Items into the Submittal Register. 

2. Create a Submittal for your subcontractor or vendor requesting 
the Submittal Items for which they are responsible, using Items 
from the Submittal Item Register.  You may want to enter 
Requested and Due dates at this point. 
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3. When the sub/vendor supplies the requested Submittal Items, 
enter the Received dates for the Items, then create a Submittal 
Package for the Items from the Submittal. 

4. Enter Submitted dates for the Items and send that Submittal 
Package to the client/architect for approval. 

5. If the Items are approved, notify the sub/vendor by routing the 
Submittal Item log to the responsible party.  If the Items are not 
approved, create a new Submittal indicating that those Items 
need to be resubmitted, and repeat the process. 

6. At the end, you may want to enter Completed dates.  

At all times, the Submittal Item Register allows you to track each 
Submittal Item as it moves back and forth between you and the 
sub/vendor or between you and the client/architect. The Submittal Item 
Register allows routing to responsible parties as needed. 

Note: You may want to set up your subcontractors or architects as “Web 
(conditional)” Spitfire users.  See the Focus on Contacts and Focus on 
Routes guides for more information. 

Submittal Item 
Workflow Example 
 
 

 

 

 

 

 

 

 

 

 

 

 

Adding to the 
Submittal Item 

Register 
The Submittal Item Register does not appear on the Documents Menu 
and cannot be created by you.  Instead, it is created as part of the project 
when the Project Setup document is first saved.  Because it is a regular 
Spitfire document, so you can attach files and documents to it, and you 
can route it, if desired.  You can enter Items directly into the register or 
you can enter Items directly onto Submittals (and Submittal Packages) 
and they will also appear in the Submittal Item Register. 

 

Submittal Item on second Submittal document.   
Submittal document is routed to sub/vendor.  Sub/vendor sends revised 
submittal item so Submittal document is Closed and new Submittal 
Package is created. 

Submittal Item on Submittal Item Register. 

Submittal Item on Submittal document.   
Submittal document is routed to sub/vendor.  Sub/vendor sends actual 
submittal item so Submittal document is Closed and Submittal Package is 
created. 

Submittal Item on Submittal Package.   
Submittal Package document is routed to architect.  Architect rejects 
Submittal Item so Item is set to Revise/Resubmit (which creates an Open 
copy of the Item when the document is saved), the Submittal Package is 
Closed and a new Submittal document is created. 

Submittal Item on second Submittal Package.   
Submittal Package document is routed to architect.  Architect approves 
Submittal Item, so the Submittal Package is Closed. 

TIP 
A “Submittal Item Log” is 
offered by sfPMS.  See 
the Spitfire Reports 
technical white paper. 
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To add Items to the Submittal Item Register: 

1. Go to the Project Dashboard and click  to open the Options 
Menu: 
 
 
 

 
 
 
 
 
 
 
 
 

2. Select  Submittal Item Register. The document will open. 

3. Add Items to the Submittal Item Register.   

4. Click  to save the Submittal Item Register.   

Notify Tab 
You can route notification of approved Submittal Items or Items with 
different statuses.  This provides a way to let your 
subcontractors/vendors know that their submittal items have been 
approved.  Although the Submittal Item Register contains all Submittal 
Items, the routed document or its corresponding print report will contain 
only those Submittal Items for which the routee is responsible. 

 

To route a notification of approved/open/etc. Items: 

1. Click on the Notify tab on the Submittal Item Register. 

2. Select the appropriate Item Notification status from the drop-
down. 

 
3. (optional)  Add a Lead Time in days. 

 
4. Add your subcontractor(s) or others to the Route Detail tab.  

TIP 
For more information 
about routing, see the 
Focus on Routes guide. 
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5. Click  to save the Submittal Item Register.  Your routee(s) will 
receive either the Submittal Item Register in their Inbox, or the 
Submittal Item Log via fax, email or hard copy printout, for 
example: 
 
 
 
 
 
 
Note: In both cases, only those Items for which the routee is 
responsible will appear. 

 

Creating a 
Submittal  

Your project can have as many Submittal documents as needed.  

 

To create a Submittal document from the Project Dashboard: 

1. Click  from the Project Dashboard to start a new Submittal 
document.   

2. (optional) Change the Description. 

3. Look up the person or company to whom you are sending the 
Submittal in the To field. 

4. Click  to save (and actually create) the document. 

5. On the Items tab, Add Items or Get Existing Items from the 
Submittal Item Register. 

6. Add other information to your Submittal as needed.   

7. (optional) If an Attachment template has been established for 
this Doc type,  will appear on the Attachments tab.  Click on 

 to create the printout file for the Submittal.  This printout file 
will be emailed or faxed to potential customers who are set up as 
“via email” or “via fax” routees (along with other attached files). 

8. Add attachments if desired and create a route if necessary. 

9. Either route the document to another person or save the 
document, then close the document window. 

10. You can reopen the document as needed to make changes to it 
and to change its status.Submittal Items 

After you save,  icons on the Items tab will identify the Item(s) as 
being on a Submittal. 

Submittals include the option for Quick Edit Mode in the Items tab.    
Usually, you do not change the status of an Item on the Submittal 
document (but rather on the Submittal Package document). 

TIP 
For more information 
about the Items tab, see 
the Focus on Document 
and Item Basics guide.  
For more information 
about attachments, see 
the Focus on Files, 
Attachments and the 
Catalog Dashboard 
guide.  For more 
information about routes, 
see the Focus on Routes 
guide. 
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Submittal 
Options Menu 

The Options menu for the Submittal document offers the following 
choices after you save:  

 

Of Particular Note 
• You can  Create Submittal Package only after you have 

entered at least one item on your Submittal and saved the 
document.  Usually you do not create the Submittal Package 
until you have received the submittals from the sub/vendor. (See 
the next section on Submittal Packages.) 

•  indicates the Source Contact for this document.  This option 
appears only after you look up a choice for the To field and save 
the Submittal document. 

Statuses for 
Submittals 

By default, the Status drop-down offers the following choices: 

 
• Closed is a final status, which closes the document. When the 

Submittal is Closed, it can no longer be edited.  Normally, you 
close the document once you have received all Items on that 
Submittal. 

 

 

 

 

 

 

 

 

 

TIP 
A description of all 
Document Options menu 
choices can be found on 
in the Focus on 
Document and Item 
Basics guide. 

Open Closed 
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Creating a 
Submittal 
Package 

There are two ways to create a Submittal Package: 

• From a Submittal document—use this method when you want to 
carry over information from an existing Submittal. 

• From the Project Dashboard—use this method when you want to 
start with a Submittal Package. 

 

To create a Submittal Package from a Submittal: 

Note: if you are following the workflow described on page 92, you should 
change the status of the Submittal to Closed and save first.  The 
Submittal should have at least one item. 

1. On the Submittal, click  to open the Options menu, then select 
 Create Submittal Package. 

2. Click  on the confirmation box that appears.  A new 
Submittal Package document will appear. 

3. (optional) Change the Description. 

4. Continue with step 4 of the following instructions, keeping in 
mind that all open Items from your Submittal will be copied onto 
the Submittal Package.  You can choose to add other items 
using either the Add New or Get Existing options. 
Also note that when you change the status of the Submittal 
Package to Closed, you will no longer be able to edit it, so you 
should not Close the Submittal Package until Items have been 
approved or rejected by the architect (see the section on 
Submittal Item Statuses on the next page). 

 

To create a Submittal Package from the Project Dashboard: 

1. Click  on the Project Dashboard to start a new Submittal 
Package document.   

2. (optional) Change the Description. 

3. In the To field, look up the person or company that will be getting 
the Submittal Package (e.g., the architect). 

4. Click  to save (and actually create) the document. 

5. (optional) If you have more than one Contact records for the To 
company, click on the Addr tab and look up the exact person you 
want to receive the Submittal Package. 

6. On the Items tab, Add Items or Get Existing Items from the 
Submittal Item Register. 

7. Add other information to your Submittal Package as needed.   

TIP 
For more information 
about Items, see the 
Focus on Document and 
Item Basics guide. 
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8. Add attachments if desired and create a route if necessary. (See 
also the section on Submittal Package Item Covers on  
page 99.) 

9. Either route the document to another person or save the 
document, then close the document window. 

10. You can reopen the document as needed to make changes to it 
and to change its status.  

Submittal Item 
Statuses 

Depending on the access that architects have within Spitfire, they will 
either be able to change the status of Items directly on the Submittal 
Package and route the document back to you, or you (or some other 
staff member) will record the status changes after hearing from the 
architect. 

 

To change the Item Status after review: 

1. Open the Submittal Package and click on the Items tab. 

2. In grid view, click on the new status for each Item.   

 

3. Click  to save.  If an Item is given a “not-approved” status (for 
example, Resubmit), the Item will be copied onto the same 
Submittal Package document with an Open status and its 
revision number will be incremented.   
 
 
 
 
 
 
 

4. Change the document status to Closed and save the Submittal 
Package. 

5. Click  to open the Document Options menu, then select  
Create Submittal from the Document Options menu: 

 
 
 

TIP 
In order for Items to 
behave as described 
here, the DocItemConfig 
| AutoCopyWhen:nn 
rule must be set to 1 for 
Submittal Packages.  
If necessary, see 
 KBA-01158. 

http://clients.spitfiremanagement.com:3280/sws/kb/index.php?ToDo=view&questId=146&catId=27
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A new Submittal document, with the open Item(s) will appear.   
This new Submittal can now be sent back to the 
subcontractor/vendor. 

6. If all Items are Approved, close the document window and notify 
the sub/vendor (see page 94). 

Submittal 
Package Item 

Covers 
You can create and use a type of bookmark template (called an Item 
Cover) for your Submittal Items.  These Item Covers take their 
information from each Item, so, for example, a document with three 
Items would have three Item Cover printouts.  Item Cover printouts are 
converted into PDF before being faxed, emailed or printed.  They can 
also be merged with files (Microsoft Word, Microsoft Excel or image files) 
that are attached to the specific Item.   

 

To view an Item’s Item Cover: 

1. Click  at the desired Item to get to detail view. 

2. While in detail view, click  to open the Item Option menu: 

 

3. Select  Print Item to open the Item’s Item Cover,  
for example: 

 

 

 

 

 

 

 

 

 

 

 

 

 

TIP 
Item Cover templates are 
created in the same 
manner as other 
bookmark templates. For 
more information, see the 
Focus on (Doc) 
Bookmark Templates 
guide. 
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Submittal 
Package 

Options Menu 
The Options menu for the Submittal Package document is similar to that 
of the Submittal document.  It offers the following choices after you save: 

  

Of Particular Note 
• Regardless of how you created the Submittal Package, you can 

 Create Submittal from the Submittal Package. 

Statuses for 
Submittal 
Packages 

By default, the Status drop-down offers the following choices: 

 
• Closed is a final status, which “closes” the document.  When a 

Submittal Package document is Closed, it can no longer be 
changed. 

 Open Closed 

TIP 
A description of all 
Document Options menu 
choices can be found on 
in the Focus on 
Document and Item 
Basics guide. 
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Compliance Notification 
Overview 

Compliance Notification documents are automatically created and routed 
to appropriate people when Commitment or Vendor requirements are out 
of compliance.  
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Where It Fits In 
You do not directly create a Compliance Notification document. 
Assuming proper setup, when a compliance item triggers an out-of-
compliance signal, a Compliance Notification document is created 
through an automatic workflow script.  Based on routing rules and 
Contact setup, the Compliance Notification document is then routed to 
the appropriate people, often through a template-generated file.  

When a compliance requirement that has triggered a Compliance 
Notification document becomes in compliance, the Compliance 
Notification document is automatically closed.  If instead, the requirement 
remains out of compliance after an allotted recurrence interval, the 
existing Compliance Notification document is automatically closed and a 
new Compliance Notification document is created and routed. 

Opening a 
Compliance 
Notification 

Compliance Notification documents can be opened from your Inbox (in 
the same manner as any other document) or from the Catalog. 

 

To find a Compliance Notification through the Catalog: 

1. Go to the Catalog Dashboard. 

2. Click the Include Documents checkbox. 

3. Click the Type checkbox and select Compliance Notification 
from the drop-down list. 

4. Click . 

 
5. Find your Compliance Notification. 

6. Click  to open the document. 

7. Review and take appropriate action. 

8. If you edit the document, click  to save it. 

TIP 
For more information, 
see the Focus on Alerts 
and Compliance guide. 
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Compliance 
Notifications 

Options Menu 
The Options Menu for the Compliance Notification document offers the 
following choices after you save:  

 

Of Particular Note 
•  indicates the vendor for the Item that is out of compliance. 

Statuses for 
Compliance 

Notifications 
By default, the Status drop-down offers the following choices: 

 
• Closed is a final status, which closes the document.  When a 

Compliance Notification document is Closed, it can no longer be 
changed. 

 

 

 

TIP 
A description of all 
Document Options menu 
choices can be found on 
in the Focus on 
Document and Item 
Basics guide. 

Open Closed 
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Receipt 
Overview 

Receipt documents track receipt of materials (or services) expected by 
Commitments.   

 

Where It Fits In 
Receipts are linked to Items on specific Commitments.   

Creating a 
Receipt 

In order for a Receipt to be created, the corresponding Commitment 
must have its status set to Committed. 

 

To create a Receipt from the Project Dashboard: 

1. Click  on the Project Dashboard to start a new Receipt 
document.   

2. Look up or enter the Commitment to which you want to link the 
Receipt. 
Note: only Commitments with a status of Committed will appear 
in the lookup.  This field is required. 

3. Look up or enter the Received By person who actually received 
or is responsible for the material (service) received. 

4. Click  to save the document. 

Click  to open the 
Commitment that is 
related to this Receipt. 
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5. On the Items tab, add Qty information to your Receipt as 
needed. 

 
6. Final receipts can be indicated on the Details tab. 

 
7. Add attachments if desired and create a route if necessary.  

8. Either route the document to another person or save the 
document, then close the document window. 

9. You can reopen the document as needed to make changes to it 
and to change its status 
Note: before you change the status to Received, you must look 
up a Received By person.  

Receipt Options 
Menu 

The Options menu for the Pay Request document offers the following 
choices after you save:  

 

Of Particular Note 
•  indicates the subcontractor/vendor on the Commitment. 

•  Related Documents provides another way for you to open 
the Commitment to which the Receipt is linked. 

 

 

TIP 
For more information 
about the Items tab, see 
the Focus on Document 
and Item Basics guide.  
For more information 
about attachments, see 
the Focus on Files, 
Attachments and the 
Catalog Dashboard 
guide.  For more 
information about routes, 
see the Focus on Routes 
guide. 

TIP 
A description of all 
Document Options menu 
choices can be found on 
in the Focus on 
Document and Item 
Basics guide. 
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Statuses for 
Receipt 

By default, the Status drop-down offers the following choices: 

 
• Both Received and Canceled are final statuses, which close the 

document.  When a Receipt document is Received or 
Canceled, it can no longer be changed. 

 

 

 

 

 

In Process 

Canceled 

Received 

TIP 
A “Receipt Log” is offered 
by sfPMS.  See the 
Spitfire Reports technical 
white paper. 
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Transmittal 
Overview 

Transmittal documents track delivery of project materials that are not 
elsewhere tracked. 

 

Where It Fits In 
Any number of Transmittal documents can be created as needed. 
 

Note: Transmittal templates can generate transmittal cover sheets for 
routees on any Doc type, offering an option other than the Transmittal 
Doc type. 

 

 

 

 

TIP 
For more information about 
Transmittal cover sheets, 
see the Focus on Routes  
guide.  
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Creating a 
Transmittal 

Transmittal documents can be created at any time during the project’s 
life cycle. 

 

To create a Transmittal document: 

1. Click  at the Project Dashboard to start a new Transmittal 
document.   

2. (optional) Change the Description. 

3. Look up a To person. 

4. Click  to save (and actually create) the document. 

5. Add information to the document, as needed. 

6. Add attachments and create a route, as necessary. 

7. Either route the document to another person or save the 
document, then close the document window. 

8. You can reopen the document as needed to make changes to  
it. 

Transmittal 
Options Menu 

The Options menu for the Transmittal document offers the following 
choices after you first save: 

 

Of Particular Note 
•  indicates the Source Contact (person/company who 

sent/received the materials being transmitted)  This option 
appears only after you look up a Contact in the Source field. 

 

 

 

 

TIP 
A description of all 
Document Options menu 
choices can be found on 
in the Focus on 
Document and Item 
Basics guide.  
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Pay Request 
Overview 

Pay Requests list and track the ongoing payment requests from vendors 
for particular Commitments.   

 

 

 

Where It Fits In 
Pay Requests are tightly integrated with Commitment documents.  Items 
on a Pay Request are drawn directly from the Commitment.  The Item 
grid allows you to enter the current payment by percent or amount and 
includes range checking for capped lines.  A Pay Request can also be 
linked to a specific CCO.  A project generally has multiple Pay Requests 
for each Commitment.  If your site is integrated with Microsoft Dynamics 
SL, Approved Pay Requests appear in the Microsoft Dynamics SL 
Subcontract Payment Review and Approval screen, ready to be posted 
and to generate a Microsoft Dynamics SL AP Voucher for payment. If 
your site is integrated with Acumatica, Approved Pay Requests generate 
one or more AP Vouchers in Acumatica. 

Pay Requests can also be created during Batch Processing. 

TIP 
For more information 
about Batch Processing, 
see the Focus on Batch 
Processing guide. 

Click  to open the 
Commitment that is related to 
this Pay Request. 
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Dates on the 
Document 

Header 
By default, there are four date fields on a Pay Request document. 

• Date indicates the date of entry or date the Pay Request is 
received.  Today’s date appears by default but can be changed. 

• Due indicates when the invoice is due. 

• Invoice indicates the date on the invoice.  This date is required 
for approval. 

• Approved indicates when the Pay Request is approved. 

Liens Tab 
The Liens tab on the Pay Request (a type of Attendee tab) allows for 
both split payments and joint payments (integrated sites only). 

 
• Vendor indicates the payee of record. 

• LW Reqd indicates whether or not a lien waiver is required. 

• Split Pay indicates a split or joint payment for the Pay Request. 
Note: Joint payments require changes to the Microsoft 
Dynamics SL check printing routine.  Your Microsoft Dynamics 
SL Implementer should contact Spitfire for information.  

• LW Recvd indicates the date the lien waiver was received. 

• Amount indicates the amount to be printed on the check.   
Note: the amount of all split checks cannot be greater than the 
Pay Request amount after retention. 

• Item indicates if the row is associated with a specific Item on the 
Pay Request. 

Creating a Pay 
Request 

In order for Pay Requests to be created, the corresponding Commitment 
must have its status set to Committed. 

There are two ways to create a Pay Request: 

• From a Commitment—use this method when you are in a 
particular Commitment document and are ready to create a Pay 
Request for that Commitment.  

• From the Project Dashboard—use this method at any point to 
create a Pay Request for any Commitment.  

 

TIP 
For information on 
secondary lien holders, 
see KBA-01390. 

http://clients.spitfiremanagement.com:3280/sws/kb/index.php?ToDo=view&questId=351&catId=54
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To create a Pay Request from a Commitment: 

Note: the Commitment must have a status of Committed. 

1. Open the Commitment document, if not already open. 

2. Open the Options menu and select Create Pay Request: 

 
3. Continue with step 3 of the following instructions. 

 

To create a Pay Request from the Project Dashboard: 

1. Click  at the Project Dashboard to start a new Pay Request 
document.   

2. Look up or enter the Commitment for this Pay Request.  
Information for the Items tab will come from this Commitment.   
Note: only Commitments with a status of Committed will appear 
in the lookup.  This field is required. 

3. Enter an invoice number at the Inv/Ref # field. 

4. Enter dates on the Document Header as appropriate (see page 
110). 

5. (optional) Look up a CCO, if appropriate and the CCO field 
appears on your document. 

6. Click  to save (and actually create) the document. The Items 
from the Commitment will appear on the Items tab. 

7. Fill in the Qty, Work, Material, or % Complete fields as needed.   

 
Note: if you are using the % Complete column and want all your 
Items to have the same percentage complete, enter the 
percentage for the first Item, then click  to copy that number to 
all Items. 
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8. Note the information on the Details tab: 

 
Green fields are the sum of all approved Pay Requests, the 
purple field is the total Commitment amount and the yellow fields 
are the sum of the Pay Request’s line items. 

9. (optional) Add to the Liens tab, if appropriate.  (See the section 
on page 110.) 

10. Add attachments if desired (for example, a scanned version of 
the subcontractor’s invoice) and create a route if necessary.  

11. Either route the document to another person or save the 
document, then close the document window. 

12. You can reopen the document and change the status as 
appropriate.  During the life cycle of the Pay Request, the status 
will change several times until you Approve it.   

Approving the 
Pay Request 

To Approve the Pay Request: 

1. When you are ready to approve the Pay Request, enter an 
Inv/Ref # number, if one isn’t there already. 

2. Enter or select an Invoice date. 

3. Look up an Approved By person. 

4. Change the status to Approved.  

5. Save the document. 

Note: If your site is integrated with Microsoft Dynamics SL, Approved 
Pay Requests appear in the Microsoft Dynamics SL Subcontract 
Payment Review and Approval screen, ready to be posted and to 
generate a Microsoft Dynamics SL AP Voucher for payment. If your site 
is integrated with Acumatica, Approved Pay Requests generate one or 
more AP Vouchers in Acumatica. 

 

 

Indicate a final 
payment by clicking 
on the checkbox. 

TIP 
If you are set up for 
Compliance tracking, out-
of-compliance 
requirements might block 
approval of the Pay 
Request.  For more 
information, see the 
Focus on Alerts and 
Compliance guide. 

TIP 
For a workflow to handle 
attaching or editing 
Compliance items after 
the Pay Request has 
been Approved, see 
KBA-01469. 

http://clients.spitfiremanagement.com:3280/sws/kb/index.php?ToDo=view&questId=426&catId=60
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Releasing 
Retention 

Integrated Sites 
Only 

If your site is integrated with an accounting system, there is no reason to 
release retention in sfPMS, as retention is released through the 
accounting package. 

 

To release retention on the Pay Request: 

1. Create a new Pay Request for the Commitment and (optionally) 
include Release Retention in the Description field.  Note: your 
Pay Request may need customization to show this field. 

2. If appropriate, click the Final Payment checkbox on the Details 
tab. 

3. On the Items tab, enter 0 (zero) on each Item’s Current field or 
leave them blank. 

4. On the Route Details tab, enter a routing note that AP should 
release a specific amount of retention. 

5. Save ( ), route and approve the Pay Request as usual. 

Non-Integrated 
Sites Only 

To release retention on the Pay Request: 

1. Create a new Pay Request for the Commitment and (optionally) 
include Release Retention in the Description field.  Note: your 
Pay Request may need customization to show this field. 

2. If appropriate, click the Final Payment checkbox on the Details 
tab. 

3. On the Items tab, enter 0 (zero) on each Item’s Current field or 
leave them blank. 

4. At the Items tab, click  to expand each Item into detail view. 

5. Type the retention amount you want to release as a negative 
number at the Curr Retention field. 

6. Click  to return to Grid view.  You will notice that the Net 
Amount for this Item accurately reflects the amount you will be 
paying (i.e., the retention you will be releasing). 

7. Save ( ), route and approve the Pay Request as usual. 
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Pay Request 
Options Menu 

The Options menu for the Pay Request document offers the following 
choices after you save:  

 

Of Particular Note 
•  indicates the subcontractor who is requesting payment. 

•  Payment Detail opens the “Payment Detail” report. 

•  Compliance opens the “Compliance Exception Log.” 

•  Related Documents provides another way for you to open 
the parent Commitment, related CCOs and other Pay Requests. 

Statuses for 
Pay Requests 

At first, the Status drop-down offers the following choices: 

 
 

• After you save the document, more choices appear: 

 
• Once you set the status to Pending (and save the document), 

you can no longer add or edit the Pay Request.  You must 
change the status back to In Process in order to edit the 
document.  

• Canceled and Approved are final statuses, which “close” the 
document.  Once Canceled or Approved, the Pay Request 
cannot be edited. 
 
 
 

TIP 
A description of all 
Document Options menu 
choices can be found on 
in the Focus on 
Document and Item 
Basics guide. 

TIP 
For a description of all 
reports, see the Spitfire 
Reports technical white 
paper. 
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• If the Pay Request is Approved and your site is integrated with 
Microsoft Dynamics SL, the Pay Request appears in the 
Microsoft Dynamics SL Subcontract Payment Review and 
Approval screen, ready to be posted and to generate a Microsoft 
Dynamics SL AP Voucher for payment. If your site is integrated 
with Acumatica, Approved Pay Requests generate one or more 
AP Vouchers in Acumatica.. 

In Process 

Canceled 

Pending Approved 

TIP 
A “Pay Request Log” is 
also offered by sfPMS.  
See the Spitfire Reports 
technical white paper. 
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CCO  
Overview 

The CCO (Commitment Change Order) document is used to make 
changes or additions to Items on a Committed Commitment.   

 

 

 
 

 

If your project is 
integrated with an 
accounting system, the 
CO field is system-
generated from the 
accounting system.  
Otherwise, it is blank.  
It is a read-only field 
that you cannot edit. 

Click  to open the 
Commitment that is related to 
this CCO. 
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Where It Fits In 
CCO documents are linked to Commitment documents and update 
Commitment Items when approved.  If so configured, approved CCO 
documents can also update the budget (see KBA-01397).  CCO 
documents can be created directly from RFQ documents that are linked 
to Commitments. Often CCO documents are created as part of a Change 
Order workflow. 

Creating a CCO 
You can create a CCO document at any time after the corresponding 
Commitment’s status has been set to Committed.  A project (and a 
Commitment) can have multiple CCOs.  There are three ways to create a 
CCO: 

• From the Project Dashboard—use this method when the CCO 
does not require a change to the Project contract, nor is a result 
of an RFQ (see below). 

• From an Awarded RFQ that was linked to a Commitment—use 
this method when changes to a Commitment start with an RFQ 
that leads to the CCO. (See page 71).  Information from the RFQ 
will be copied to the CCO. 

• From within a Change Order—use this method when a change 
to the Commitment also causes a change to the Project contract. 
(See the Change Order Management white paper.) 

 

To create a CCO document from the Project Dashboard: 

1. Click  on the Project Dashboard to start a new CCO 
document.   

2. Look up or enter the Commitment to which you want to link the 
CCO. 
Note: only Commitments with a status of Committed will appear 
in the lookup.  This field is required. 

3. On the Details tab, change the Title to something more 
descriptive 

4. On the Items tab, either Add New Items or Get Existing Items 
from the Commitment.  (See KBA-01459 for more information.) 

o (If your site is integrated) Each item should have a Cost 
Code, Account Category and GL Account.  You will 
not be able to approve the document without this 
information.  Look up the fields necessary. 

5. Add other information to your CCO as needed.  

6. Add attachments if desired and create a route if necessary.  

7. Either route the document to another person or save the 
document, then close the document window. 

8. You can reopen the document as needed to make changes to it 
and to change its status, first to Pending and then to 
Approved. 

TIP 
For more information 
about the Items tab, see 
the Focus on Document 
and Item Basics guide.  
For more information 
about attachments, see 
the Focus on Files, 
Attachments and the 
Catalog Dashboard 
guide.  For more 
information about routes, 
see the Focus on Routes 
guide. 

TIP 
When editing Items on 
your CCO, you can 
increase (with positive 
numbers) or decrease 
(with negative numbers) 
your Units or Amounts. 

http://www.spitfiremanagement.com/only/kb/index.php?ToDo=view&questId=358&catId=32
http://clients.spitfiremanagement.com:3280/sws/kb/index.php?ToDo=view&questId=417&catId=40
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Approving a 
CCO 

When a CCO is Approved, changes are made to the Commitment: new 
Items are added and existing Items are updated.  In addition, if properly 
configured (see KBA-01397), the approved CCO updates the budget. 

 

To Approve a CCO: 

Note: The CCO must have a status of Pending before it can be 
Approved. 

1. When you are ready to approve the CCO, look up a Vendor 
Approver. 

2. Look up an Internal Appr. 

3. Change the status either to Approved.  

4. Save the document. Once the document is approved, the 
expense amount of CCO Items will be reflected on the 
corresponding Commitment’s Detail tab.  

CCO Options 
Menu 

The Options menu for the CCO offers the following choices after you 
save: 

  

Of Particular Note 
• The  Commitment-vs-Budget option opens the “Commitment 

Budget Comparison” report. 

•  Related Documents provides another way for you to open 
the Commitment which the CCO affects. 

•  indicates the subcontractor. 

TIP 
A description of all 
Document Options menu 
choices can be found on 
in the Focus on 
Document and Item 
Basics guide. 

http://clients.spitfiremanagement.com:3280/sws/kb/index.php?ToDo=view&questId=358&catId=32
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Statuses for 
CCOs 

When the CCO is first created, the Status drop-down offers the following 
choices: 

 
• When a CCO is Canceled, it is considered closed and can no 

longer be changed. 

• Once you set the CCO status to Pending (and save the 
document), the CCO becomes read-only, new line items are 
added to the Commitment (with Item numbers that fit in with the 
existing line numbers), and the status drop-down changes:  

 
• While the document is Pending, you can change the status back 

to In Process in order to edit the document. 

• Canceled and Committed or Approved are final statuses, 
which close the document.  When a CCO document is 
Canceled, Committed or Approved, it can no longer be edited. 

 

 

 

 

 

 

TIP 
The DocTypeConfig | 
AllowUnapprove rule 
can allow a user to 
reverse an Approval on a 
Change Order.  See 
KBA-01154. 

In Process Pending 
Committed/
Approved 

Commitment Committed 

Canceled 

TIP 
A “CCO Log” is offered 
by sfPMS. See the 
Spitfire Reports technical 
white paper. 

http://clients.spitfiremanagement.com:3280/sws/kb/index.php?ToDo=view&questId=136&catId=42
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File Batch 
Overview 

File Batch documents (formerly called AP Scans) are either created by 
Spitfire’s Batch Upload Tool or from the Site Options menu and are 
usually routed through predefined routes to the person responsible for 
processing the batch files attached to the document.   

  
 

TIP 
For more information, 
see the Focus on Batch 
Processing guide. 
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Where It Fits In 
File Batch documents are part of Batch Processing.  They are either 
created by the Batch Upload Tool (and often not opened directly) or are 
created from the Site Options menu for the manual attachment of batch 
files.  When the File Batch document is routed to someone’s Inbox, the 
attached files can be processed through the Batch Viewer.  The Batch 
Viewer allows the attached image files to be attached to Pay Requests or 
AP Vouchers. 

File Types 
Supported 

The Batch Viewer supports the following file types, all of which can be 
attached to the File Batch document: 

• .PDF 

• .TIFF 

• .DOC, .DOCX 

• .DOT, .DOTX 

• .RTF 

• .HTM, .HTML, .MHTML 

• .TXT 

Creating a File 
Batch 

Document 
You can create a File Batch document at any time.  File Batch 
documents are not part of projects.  There are two ways to create a File 
Batch document: 

• From the Batch Upload Tool, which automatically creates the 
File Batch document.  Use this method when you have many 
files to scan.  (For more information, see the Focus on Batch 
Processing guide.) 

• From the Site Options menu—use this method when you don’t 
need to scan files, but rather just attach them to a document 
because they are already in electronic form. 

 

To create a File Batch document from the Site Options menu: 

1. Select Create Document from the Site Options menu: 
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2. Select Create File Batch: 

 
A File Batch document window will open. 

3. Click  to save the document. 

4. Use either the Add Files tool ( ) if the files were emailed to you 
or the Doc Attach tool ( ) if the files were previously uploaded 
to your Spitfire Catalog, to attach the files to the File Batch 
document.  You can attach as many files as you want in this 
“batch”. 

5. Either route the document to another person or save the 
document, then close the document window.  

Dealing with a 
File Batch 
Document 

When File Batch document appears in your Inbox, you can either open 
the document (to review the attached files or route the document to 
someone else, for example) or open the Batch Viewer to process the 
images that are attached to the document. 

 

• Click  to open the document from the Inbox.  As with any Doc 
type, you can add a note, view attached files, change the status 
and route the document. 

• Click  to open the Batch Viewer from the Inbox.  The Batch 
Viewer displays scanned images and (if integrated to Microsoft 
Dynamics SL) connects to Microsoft Dynamics SL Accounts 
Payable Voucher and Adjustment Entry. As you process the 
scanned images, you are able to attach each to a Pay Request 
or AP Voucher document or to route the image to someone else.   

 

 

 

TIP 
For more information 
about the Batch Viewer, 
see the Focus on Batch 
Processing guide. 

TIP 
For more information 
about attachments, see 
the Focus on Files, 
Attachments and the 
Catalog Dashboard 
guide.  For more 
information about routes, 
see the Focus on Routes 
guide. 
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File Batch 
Options Menu 

The Options menu for the File Batch document offers the following 
choices after you save: 

 

Of Particular Note 
•  links to the Batch Viewer (or Microsoft Dynamics SL). 

Statuses for 
File Batch 

By default, the Status drop-down offers the following choices: 

 
• Closed is a final status, which closes the document.  When a 

File Batch document is Closed, it can no longer be changed. 

 

 

 Closed 

Open 

Inquiry 
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Scanned Timecards 
Overview 

Scanned Timecards documents are created by Spitfire’s Batch Upload 
Tool and usually routed through automated routes to the person 
responsible for processing the timecards attached to the document.   

 

Where It Fits In 
Scanned Timecards documents are part of Batch Processing.  They are 
created by the Batch Upload Tool and are often not opened directly.  
Instead a Scanned Timecards document is routed to someone’s Inbox so 
that the attached files can be processed through the Batch Viewer.  The 
Batch Viewer allows the attached image files to be attached to other 
Spitfire documents. 

TIP 
For more information, 
see the Focus on Batch 
Processing guide. 
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Dealing with 
Scanned 

Timecards 
When a Scanned Timecards document appears in your Inbox, you can 
either open the document (to review the attached files or route the 
document to someone else, for example) or open the Batch Viewer to 
process the images that are attached to the document. 

 

• Click  to open the document from the Inbox.  As with any Doc 
type, you can add a note, view attached files, change the status 
and route the document. 

• Click  to open the Batch Viewer from the Inbox.  As you 
process the scanned images, you’ll be able to attach each to a 
Spitfire document or to route the image to someone else.   

Scanned 
Timecards 

Options Menu 
The Options menu for the Scanned Timecards document offers the 
following choices after you save: 

 

Of Particular Note 
 links to the Batch Viewer. 

Statuses for 
Scanned 

Timecards 
By default, the Status drop-down offers the following choices: 

 
• Closed is a final status, which closes the document.  When a 

Scanned Timecards document is Closed, it can no longer be 
changed. 

TIP 
For more information 
about the Batch Viewer, 
see the Focus on Batch 
Processing guide. 

Open Closed 
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Site Photo 
Overview 

The Site Photo document contains photos taken during the course of 
your project.   

 

Where It Fits In 
You can create any number of Site Photo documents for your project and 
attach photo files to the documents at any time.  Photos can be attached 
through the Doc Attach or Add Files tool or through a mobile device 
running the Spitfire App for Android.  

Creating a Site 
Photo 

Site Photo documents can be created at any time for a project. 

To create a Site Photo document: 

1. Click  at the Project Dashboard to start a new Site Photo 
document.   

2. (optional) Change the Description. 

Click on either the 
thumbnail or the view 
icon to see the photo. 
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3. Click  to save (and actually create) the document. 

4. Add other information to your Site Photo as needed.   

5. Add photos as Attachments to the document. 

o Click  to attach photos that are already in the Spitfire 
Catalog. 

o Click  to upload or scan photos that are on your 
computer. 
Note:  once your document is created, you can also 
attach photos by uploading them from a mobile device. 

6. Create a route as necessary.  

7. Either route the document to another person or save the 
document, then close the document window. 

8. You can reopen the document as needed to make changes to it 
and to change its status. 

Site Photo 
Options Menu 

The Options menu for the Site Photo document offers the following 
choices after you save: 

 
 

Statuses for 
Site Photo 

By default, the Status drop-down offers the following choices: 

 
• Closed is a final status, which closes the document.  When a 

Site Photo document is Closed, it can no longer be changed. 

 

TIP 
For more information 
about attachments, see 
the Focus on Files, 
Attachments and the 
Catalog Dashboard 
guide.  For more 
information about 
Spitfire’s mobile app, see 
the Using Spitfire’s App 
for Android technical 
white paper. 

TIP 
A description of all 
Document Options menu 
choices can be found on 
in the Focus on 
Document and Item 
Basics guide. 

Open Closed 
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Project Dashboard Photo 
Overview 

Project Dashboard Photo is a special Doc type used internally by sfPMS 
to hold the photos that appear on a Project Dashboard’s Photo part.  
Since you can upload photos to this part directly, you cannot access this 
special-use Doc type. 

 

  

Where It Fits In 
Although you cannot access this Doc type directly, you can select the 
Doc type at certain drop-downs. 

Designating a 
File as the 

Project 
Dashboard 

Photo 
sfPMS uses the most recent photo attached to the Project Dashboard 
Photo document as the one displayed on the Project Dashboard.  If, 
instead of using the Add Images tool from the Photo part to upload a new 
photo (as shown above), you want to designate an existing project file as 
your Dashboard photo, you can do so through the File Properties for that 
file. 

 

To designate a file as the Dashboard Photo: 

1. Go to the Files part of your Project Dashboard. 

2. (optional) Use the column filters and/or Preview to find the photo 
you want to designate as the Project Dashboard photo. 

 

3. Click  at the photo that you want to appear on the Photo part 
of the dashboard. 

Click  to upload the Project 
Dashboard photo through the 
Add Files tool. 

TIP 
For more information 
about the Add Files tool, 
see the Focus on Files, 
Attachments and the 
Catalog Dashboard 
guide.   
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4. Select Properties. 

5. Select Project Dashboard Photo from the Type drop-down. 

 

6. Click  to save, then  to close the File Properties window. 
Provided that the new photo actually has a more recent 
Cataloged date than any other Project Dashboard Photo, the 
new photo will appear in the Photo part the next time the part is 
refreshed. 

Finding Project 
Dashboard 

Photo Files in 
the Catalog 

Because Dashboard photos are internally attached to the Project 
Dashboard Photo Doc type, you can filter on this Doc type when 
searching for photo files. 

To find Project Dashboard Photo files in the Catalog: 

1. In the Catalog Dashboard, use both the Include Files and Doc 
Type (Project Dashboard Photo) filters to find photos that are, or 
have been, Dashboard photos. 

2. (optionally) Click the Preview filter. 

3. Click the  button to see your results. 
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Correspondence, Daily Field Report, Task, Warranty 
Overview of 

Daily Field 
Report 

Daily Field Report documents are used for regular communication about 
the project.  
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Overview of 
Correspondence 

Correspondence documents track various forms of correspondence with 
others (for example, letters, phone calls, emails, etc.).   

 

Overview of 
Warranty 

Warranty documents track all types of warranties that are not elsewhere 
spelled out for a project.   
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Overview of 
Task 

Task documents communicate tasks among project team members.   

 

Where They Fit 
In 

Any number of Correspondence, Daily Field Report, Task and Warranty 
documents can be created as needed.  These Doc types can be 
customized to better reflect the type of communication you want tracked. 
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Creating One of 
These 

Documents 
Correspondence, Daily Field Report, Task and Warranty documents can 
be created at any time during a project’s life cycle. 

 

To create a new document: 

1. Click  at the Project Dashboard to start a new document.   

2. (optional) Change the Description. 

3. Look up the person(s) with whom you are communicating. 

4. Click  to save (and actually create) the document. 

5. Add other information to your document as needed.  

6. (for Daily Field Report) If the report concerns safety issues, click 
the Safety Meeting checkbox on the Details tab. 

7. (optional) If an Attachment template has been established for the 
Doc type,  will appear on the Attachments tab.  Click  to 
create the printout file for the document.  This printout file will be 
emailed or faxed to potential customers who are set up as “via 
email” or “via fax” routees (along with other attached files). 

8. Add attachments if desired and create a route if necessary.  

9. Either route the document to another person or save the 
document, then close the document window. 

10. You can reopen the document as needed to make changes to it 
and to change its status. 

 

Note: Task documents can also be created from the Site Options menu: 

 

To create a Task from the Site Options menu: 

1. Select Create Document: 

 
2. Select Invitation to Bid. 

 
The Task document window will open. 

TIP 
For more information 
about attachments, see 
the Focus on Files, 
Attachments and the 
Catalog Dashboard 
guide.  For more 
information about routes, 
see the Focus on Routes 
guide. 
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Document 
Options Menu 1 

The Options menu for the Correspondence, Task and Warranty 
documents offers the following choices after you first save: 

 

Of Particular Note 
•  indicates the Source Contact (person/company with whom 

you are communicating) for this document.  This option appears 
only after you look up a Contact in the appropriate field (e.g., 
Foreman, To). 

Document 
Options Menu 2 

 

The Options menu for the Daily Field Report documents offers the 
following choices after you first save: 

 

Of Particular Note 
• The  Site Conditions option on the menu defaults to the Site 

Conditions log. 

Statuses for 
Documents 

By default, the Status drop-down offers the following choices: 

 
• Closed is a final status, which closes the document.  When a 

document is Closed, it can no longer be changed. 

 

 

 

TIP 
A description of all 
Document Options menu 
choices can be found on 
in the Focus on 
Document and Item 
Basics guide.  

Open Closed 

TIP 
For more information 
about the Site Conditions 
log, see the Spitfire 
Reports technical white 
paper. 
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Milestone, Field Work Order, Inspection, Safety Notice, 
Team Message and Certificates & Approvals 

Overview of 
Milestone 

Milestone documents record important achievements reached during the 
course of a project.   
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Overview of 
Field Work 

Order 
Field Work Order documents are used for regular project-related 
directives and work orders.  
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Overview of 
Inspection 

The Inspection document tracks information concerning inspections and 
tests and often serves as a “wrapper” for routing attached inspection 
reports.   
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Overview of 
Safety Notice 

Safety Notice documents track safety incidents and notices received 
during the course of the project.   
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Overview of 
Team Message 

Team Message documents communicate project-related messages 
among team members.   
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Overview of 
Certificates and 

Approvals 
Certificate and Approval documents track the need and obtainment of 
certificate and approvals and often serves as a “wrapper” for routing 
attached certificate files..   

 

Where They Fit 
In 

Projects can have any number of Milestone, Field Work Order, 
Inspection, Safety Notice, Team Message and Certificate and Approval 
documents, created as needed. 
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Creating One of 
These 

Documents  
Milestone, Field Work Order, Inspection, Safety Notice, Team Message 
and Certificate and Approval documents can be created at any time 
during a project’s life cycle. 

 

To create a new document: 

1. Click  at the Project Dashboard to start the new document.  

2. (optional) Change the Description. 

3. Enter appropriate dates. 

4. (for Team Message) Look up a From person (i.e, the person 
who is sending out the message, probably you.) 

5. Click  to save (and actually create) the document. 

6. Add information to the Notes tab and elsewhere on the 
document, as desired. 

7. Add attachments if desired and create a route if necessary.  

8. Either route the document to another person or save the 
document, then close the document window. 

9. You can reopen the document as needed to make changes to it 
and to change its status. 

Document 
Options Menu 

The Options menu for Milestone, Field Work Order, Inspection, Safety 
Notice and Team Message documents offers the following choices after 
you save: 

 

Statuses for 
These 

Documents 
By default, the Status drop-down offers the following choices: 

 
• Closed is a final status, which “closes” the document.  When a 

document is Closed, it can no longer be edited. 

TIP 
A description of all 
Document Options menu 
choices can be found on 
in the Focus on 
Document and Item 
Basics guide. 

Open Closed 

TIP 
For more information 
about attachments, see 
the Focus on Files, 
Attachments and the 
Catalog Dashboard 
guide.  For more 
information about routes, 
see the Focus on Routes 
guide. 
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Issue 
Overview 

An Issue document records problems or situations that occur during the 
course of a project.   

 

Where It Fits In 
A project can have multiple Issue documents, created as needed.  Once 
in the project, an Issue document can easily be attached to other 
documents that stem from or deal with the issue.  When an Issue 
document is attached to another document, that other document is 
attached to the Issue document also.  Because of this functionality, the 
Attachments tab of an Issue document provides easy access to the 
issue-related documents. 
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Creating an 
Issue 

Issue documents can be created at any time during the project’s life 
cycle. 

 

To create an Issue: 

1. Click  at the Project Dashboard to start a new Issue 
document.   

2. (optional) Change the Description. 

3. Click  to save (and actually create) the document. 

4. Add New Items to the Cost Codes tab.  (This is a type of Items 
tab.) 

o Look up a Cost Code for each Item. 

5. Add other information to your document, as needed. 

6. Add attachments if desired and create a route if necessary.  

7. Either route the document to another person or persons or save 
the document, then close the document window. 

8. You can reopen the document as needed to make changes to it 
and to change its status.   

Attaching an 
Issue to 
Another 

Document 
To attach an Issue to a related document: 

1. Open the related document. 

2. Click the Attachments tab on the related document. 

3. Click  at the bottom of the Attachments tab. 

 
 
The DocAttach window, filtered for Issue documents,  will open. 

 

TIP 
See the Focus on Files, 
Attachments and the 
Catalog Dashboard guide 
for more information. 

TIP 
For more information 
about the Items tab, see 
the Focus on Document 
and Item Basics guide.  
For more information 
about attachments, see 
the Focus on Files, 
Attachments and the 
Catalog Dashboard 
guide.  For more 
information about routes, 
see the Focus on Routes 
guide. 
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4. Click  and  to attach the Issue to that document. 
Note: when you attach an Issue to another document, that 
document is also attached to the Issue document. 

Issue Options 
Menu 

The Options menu for the Issue document offers the following choices 
after you save: 

 

Statuses for 
Issues 

By default, the Status drop-down offers the following choices: 

 
• Closed is a final status, which “closes” the document. When an 

Issue is Closed, it can no longer be changed. 

 

 

 

 

 

In Process-Architect 

Open Closed 
In Process-GC 

In Process-Owner 

In Process-Sub 

TIP 
A description of all 
Document Options menu 
choices can be found on 
in the Focus on 
Document and Item 
Basics guide. 
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RFI 
Overview 

RFI (Request for Information) documents track your requests for 
information throughout the project.   

 

Where It Fits In 
RFIs can lead to Proposed CO or Change Order documents, when the 
result of an inquiry is a change to the project.  A project can have 
multiple RFI documents, created as needed. 

TIP 
For more information 
about the role of an RFI 
in a Change Order 
workflow, see the 
Change Order 
Management white 
paper. 
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Response Field 
What you enter in the Response field on the Info tab will be copied onto 
a Proposed CO/Change Order document if you create the Proposed 
CO/Change Order from the RFI.  If you have permission to do so 
(because you are the Originator of the document, for example) you can 
type directly in the field.  Others, to whom the document is routed, might 
not have permission to type in the Response field.  However, they can 
enter text in the Rsp field on the Route Detail—or send a reply email with 
a note--and this text will be copied to the Response field with a date/time 
stamp: 

 
 

By design, if other routees add other Rsp notes, those notes will be pre-
pended in the Response field, meaning that the newest note will be 
added to the top of the field, for example: 

TIP 
The EMailText | 
ResponseEchoTo rule 
allows you to indicate a 
different note field to 
receive the contents of 
the Rsp field.  For more 
information see the 
technical white paper 
Rules and Rule Values, 
the Focus on System 
Administration guide or 
your System 
Administrator. 
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When you (the originator) reopen the document, you can edit the 
Response field.  If the RFI is part of a workflow, the text in this field will 
be copied to other locations (for example: the Scope and Change Item 
Description fields on a Proposed CO) minus the date/time/name stamp: 

 

 
 

 

 

TIP 
Changing the Response 
field will not change the 
Rsp field on the routee’s 
row.  You can always 
check that field to see 
what was originally 
posted in the Response 
field. 
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Creating an RFI 
You can create RFIs at any point during the project’s life cycle. 

 

To create an RFI document: 

1. Click  at the Project Dashboard to start a new RFI document. 

2. Change the Description. 

3. Look up the From person.  This is the person who is requesting 
information.  This person is the source contact for this document. 

4. Look up the person who is Responsible for providing the 
requested information. 

5. Enter a Due date. 

6. Click  to save (and actually create) the document. 

7. Enter your request/question on the Info tab’s Info Required tab. 

8. Fill out or look up other fields on the document, as appropriate. 

9. (optional) If an Attachment template has been established for the 
Doc type,  will appear on the Attachments tab.  Click on  to 
create the printout file for the document.  This printout file will be 
emailed or faxed to potential customers who are set up as “via 
email” or “via fax” routees (along with other attached files). 

10. Add attachments if desired.  

11. Either route the document to the Responsible person or save the 
document, then close the document window. 

12. You can reopen the document as needed to make changes to it 
and to change its status.   

RFI Options 
Menu 

The Options menu for the RFI document offers the following choices 
after you save: 

 

Of Particular Note 
•  Create Proposed CO appears only after you save the RFI. 

The Proposed CO will carry over some information from the RFI. 
(See page 150.)   
 
Note: if your site does not have the Proposed CO Doc type 
active, the option will say Create Change Order instead. 

TIP 
A description of all 
Document Options menu 
choices can be found on 
in the Focus on 
Document and Item 
Basics guide. 

TIP 
For more information 
about attachments, see 
the Focus on Files, 
Attachments and the 
Catalog Dashboard 
guide.  For more 
information about routes, 
see the Focus on Routes 
guide. 
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Statuses for 
RFIs 

By default, the Status drop-down offers the following choices: 

 
• Closed is a final status, which closes the document.  When an 

RFI document is Closed, it can no longer be changed. 

 

 

 

 

 

Open Closed 



 Page 150 

Focus on Doc Types and Project Workflow  Proposed CO/Change Item Register 

Proposed CO, Change Item Register 
Overview 

A Proposed CO (Change Order) document contains one or more 
proposed changes to the Project Contract. The Change Item Register is 
the master list of all Change Items (Items that appear on Proposed COs 
and Change Orders) for a project.  

 
Note: a picture of the Change Item Register appears on page 154. 

Where It Fits In 
Proposed COs can be created directly or from RFI documents.  
Proposed COs can lead to Change Order documents. A project may 
have several Proposed COs; however, each project has only one 
Change Item Register document.  The Change Item Register contains all 
Change Items for the project.  When you update a Change Item on a 
Proposed CO (or Change Order), the update is immediately reflected on 
the Change Item Register. 

TIP 
For more information 
about the role of a 
Proposed CO in a 
Change Order workflow, 
see the Change Order 
Management white 
paper. 
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Change Items 
You can have any number of Change Items on your Proposed CO. Each 
Change Item is its own entity with its own status.  Whether you view a 
particular Change Item from a Proposed CO (or Change Order) or from 
the Change Item Register, it is the same Item.  These Items can then be 
Approved or Canceled on an individual basis.  Only Approved Items will 
be carried over to a Change Order document.  

Creating a 
Proposed CO 

Proposed CO documents can be created at any time.  There are two 
ways to create a Proposed CO: 

• From a saved RFI—use this method when you want information 
from an RFI to be carried over to the Proposed CO, as is often 
the case during a Change Order workflow.  

• From the Project Dashboard—use this method when the 
Proposed CO is your starting document. 

 

To create a Proposed CO document from an RFI: 

1. Select Create Proposed CO from the RFI’s Document Options 
menu: 

 

2. Click   at the confirmation box. The Proposed CO 
document will appear. 

3. Although a Closed status is not required on the RFI in order to 
create the Proposed CO, you might decide to change the RFI’s 
status to Closed now.  In any case, you can close the RFI 
document window. 

4. Continue with step 6 of the following instructions, keeping in 
mind that some information (Description, Change Item) will 
already appear on the document from the RFI..   

Note: the Change Item that appears on the Proposed CO also appears 
on the Change Item Register. 

 

To create a Proposed CO document from the Dashboard: 

1. Click  at the Project Dashboard to start a new Proposed CO 
document. 

2. Change the Description on the Details tab. 
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3. (optional) Select a Contract Type for the eventual Change 
Order.  You will be able to enter this information later, on the 
Change Order document itself, also. 

4. Click  to save (and actually create) the document. 

5. On the CI tab, Add New Items. 
Note: while you may have more than one Item on your Proposed 
CO, you need not have more than one Item.  Items that you add 
here also appear on the Change Item Register. 

6. Fill out or look up other fields on the on the document, as 
appropriate. 

7. Add attachments if desired and create a route, if necessary.  

8. Either route the document or save the document, then close the 
document window. 

9. You can reopen the document as needed to make changes to it, 
to change the status of a Change Item, and to change the 
document status. 

o If you want to create a Change Order document from the 
Proposed CO, change the status to Closed first.  

Approving 
Change Items 

To Approve/Cancel a Change Item on a Proposed CO: 

1. On the CI tab of a Proposed CO, find the Item you want to 
Approve or Cancel. 

2. Select either Approved or Canceled from the Item Status drop-
down: 

 
Only Change Items with a status of Approved are copied over to 
the Change Order created from the Proposed CO. 

3. Save ( ) the document. 

Note: the status of the Change Item can remain Proposed or changed 
to Requested if you do not want to cancel the Item, but are not ready to 
approve it yet. 

 

 

TIP 
For more information 
about the Change Items 
tab and Budget Entries, 
see the Change Order 
Management technical 
white paper. 
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Proposed CO 
Options Menu 

The Options menu for the Proposed CO document offers the following 
choices after you save: 

 

Of Particular Note 
• After you change the Proposed CO’s status to Closed (and if 

you have at least one approved Item), the Options menu offers 

the choice to  Create a Change Order: 

 
 

Statuses for 
Proposed COs 

By default, the Status drop-down offers the following choices: 

 
• Closed is a final status, which “closes” the document.  When a 

Proposed CO document is Closed, it can no longer be changed. 
The status must be Closed before you can create a Change 
Order from the Proposed CO. 

 

 

 

 

 

 

 

 

 

 

TIP 
A description of all 
Document Options menu 
choices can be found on 
in the Focus on 
Document and Item 
Basics guide 

Open Closed 
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Change Item 
Register 

The Change Item Register is the master list of all Change Items (Items 
that appear on Proposed COs and Change Orders) for a project.  You 
can open the Change Item Register after you have added at least one 
Change Item to a Proposed CO or Change Order.   

 
 

 

 

 

 

 

 

To open and view the Change Item Register: 

1. Go to the Project Dashboard and click  to open the Options 
Menu: 

 

2. Click  to open the Change Item Register. 

When you click on it, the  icon opens the Proposed CO or Change Order where 
the Item can be found.  Specifically, colors indicate: 

 = no such document created yet 

 = document is Open  

 = document is Closed 
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Change Item 
Register 

Options Menu 
The Options menu for the Change Item Register document offers the 
following choices after you save: 

 
Of Particular Note 

•  CI Log opens the Project CO Log.  

 

 

TIP 
A description of all 
Document Options menu 
choices can be found on 
in the Focus on 
Document and Item 
Basics guide 

TIP 
A description of all 
reports can be found in 
the Spitfire Reports 
technical white paper. 
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Change Order 
Overview 

Change Orders are used to track changes to the project’s revenue and 
expenses.    

 

If your project is 
integrated with an 
accounting system, 
the Contract field is 
system-generated 
from the accounting 
system.  Otherwise, it 
is blank.  It is a read-
only field that you 
cannot edit. 

TIP 
For more information 
about Change Orders, 
see the Change Order 
Management white 
paper. 
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Where It Fits In 
Change Order documents cannot be created until the Project Setup is 
Committed.  Each Change Order document updates your budget and 
contract value, and can update your schedule of values (SOV).  Change 
Orders can be created from Proposed COs or RFI documents. Change 
Orders integrate with (and can create) RFQs, Commitments, and 
Commitment Change Orders (CCOs).   

Fiscal Period 
The optional Period field on the Details tab is used to indicate the fiscal 
period to which expenses and revenue should post.  The Period can be 
changed for budget revisions, in the format YYYYMM (for example, 
201103 for March 2011).  The current year and month appear as the 
fiscal period by default on the Change Order. 

 

Expense and 
Revenue Icons 

Since sfPMS V4.1, Spitfire has been configured so that the Change 
Order status has no effect on the budget. Instead, you update the 
expenses and revenue in the budget through the  and  icons.  (For 
alternate set up, talk to your implementer.)  

Change Items 
The Items on a Change Order are often referred to as Change Items; 
therefore, the tab is labeled CI. The CI tab found on Proposed CO and 
Change Order documents functions in the same way as other Item tabs; 
however, in Detail view, the CI tab offers the icon  not seen elsewhere.  
In addition, each Change Item has its own status. 

The  icon opens the Budget Entries window for the Proposed CO or 
Change Order’s Change Item.  The Budget Entries window allows you to 
add Self-Perform and Revenue budget lines as well as create RFQ, 
Commitment and CCO documents.  You can also add allocations and 
markups for all your budget entries. 

 

 

 

 
 

 

 

 

TIP 
The project’s Change 
Item Register contains 
all Change Items for a 
project.  Change 
Items that are neither 
cancelled, nor already 
on a Change Order 
can be added to a 
Change Order 
document through the 
Get Existing option 
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For more information about Change Item statuses and the Budget 
Entries window, see the Change Order Management white paper. 

Creating a 
Change Order 

You can create a Change Order document at any time after the Project 
Setup’s status has been set to Committed.  A project can have multiple 
Change Orders.  There are three ways to create a Change Order: 

• From the Project Dashboard (see below)—use this method when 
the Change Order is your starting document. 

• From an RFI (see page 148)—use this method when you want 
information from an RFI to be carried over directly to a Change 
Order (because you do not use Proposed COs). 

• From a Closed Proposed CO (see page 153)—use this method 
when you want information from a Proposed CO to be carried 
over to the Change Order, as is often the case during a Change 
Order workflow.   

 

To create a Change Order document from the Dashboard: 

1. Click  at the Project Dashboard to start a new Change Order 
document. 

2. Change the Description on the Details tab. 

3. Select a Contract Type at the Document Header. 

4. Click  to save (and actually create) the document. 

5. On the CI tab, either Get Existing Items from the Change Item 
Register or Add New Items. 

6. Fill out or look up other fields on the on the document, as 
appropriate. 
Note: What you enter on the Scope tab appears on the Project 
CO Request Form. 

7. (optional) If an Attachment template has been established for the 
Doc type,  will appear on the Attachments tab.  Click on  to 
create the printout file for the document.  This printout file will be 
emailed or faxed to potential customers who are set up as “via 
email” or “via fax” routees (along with other attached files). 

8. Add attachments if desired and create a route, if necessary.  

9. Either route the document or save the document, then close the 
document window. 
Note: when you save a Change Order that has posted revenue 
amount in its Budget Entries, that amount is added to the Key 
Performance Indicators part on the Project Dashboard. 

TIP 
While you may have 
more than one Item on 
your Change Order, you 
need not have more than 
one.  Items that are 
added to a Change Order 
also appear on the 
Change Item Register 
when you save. For more 
information about the CI 
tab, see the Change 
Order Management white 
paper 
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10. You can reopen the document as needed to make changes to it, 

to change the status of a Change Item, to change the document 
status and to click the  and  icons when you are ready to 
post your expense and revenue changes. 

Change Order 
Options Menu 

The Options menu for the Change Order document offers the following 
choices after you save: 

 

Of Particular Note 
•  CI Payment Log opens the Change Item Payment Log. 

Statuses for 
Change Orders 

When the Change Order is first created, the Status drop-down offers the 
following choices: 

 
• If you set the status to Pending (and save the document), you 

can no longer add Change Items (on the CI tab).  When the 
document is Pending the Status drop-down changes: 

 
• While the document is Pending, you can change the status back 

to In Process in order to edit the document. 

TIP 
The DocTypeConfig | 
AllowUnapprove rule 
can allow a user to 
reverse an Approval on a 
Change Order.   
See KBA-01154. 

TIP 
A “Change Item” report, 
“Change Order Detail” 
report, and a “Project CO 
Log” are also offered by 
sfPMS.  See the Spitfire 
Reports technical white 
paper for information on 
all reports. 

http://clients.spitfiremanagement.com:3280/sws/kb/index.php?ToDo=view&questId=136&catId=42%22,
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• Approved does not close the document, nor make the document 
read-only.  However, once a Change Order has a status of 
Approved, the status cannot be changed. 

• Cancelled and Rejected “close” the document.  When a Change 
Order document is Closed, it can no longer be changed. 

 
 
 
 

Cancelled, 
Rejected 

In Process Pending Approved 
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Forecast 
Overview 

Forecast documents detail financial forecasts throughout your project.  
Each Forecast document opens the BFA workbook in Forecast mode.  

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

TIP 
For more information 
about the BFA workbook 
in Forecast mode, see 
the Focus on Forecast 
and Analysis guide. 
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Where It Fits In 
Forecast documents and corresponding BFA workbooks require that the 
project have an approved Initial Budget.  The BFA workbook in Forecast 
mode takes a complete financial snapshot of your project, which requires 
your budget information.  A project can have any number of Forecast 
documents. 

Fiscal Period 
The Period field on the Details tab is used to indicate the fiscal period to 
which the approved forecast should post.  The Period can be changed in 
the format YYYYMM (for example, 201103 for March 2011).   

 

Creating a 
Forecast 

Once a project has an approved budget, Forecast documents can be 
created at any point during the project’s life cycle. 

To create a Forecast document: 

1. Click  at the Project Dashboard to start a new Forecast 
document. 

2. (optional) Change the Description and type a Note. 

3. (optional) Change the Period if you want to post to a different 
fiscal period. 

4. Click  to save (and actually create) the document.   
Note: the  icon will not appear until the first time you save the 
document. 

5. Click  to open the BFA workbook in Forecast mode.  (For 
more information about the BFA workbook in Forecast mode, 
see the Focus on Forecast and Analysis guide.)  The workbook 
will show your budget’s latest snapshot data, including any 
approved forecast data. 

6. When you save and close the BFA workbook and return to the 
Forecast document, you will notice that the icon has changed to 

. 

7. Add attachments to the document if desired and create a route, if 
necessary.  

8. Either route the document or save the document, then close the 
document window. 

9. You can reopen the document as needed to make changes to it, 
and to change the document status.  You can edit the BFA 
workbook in Forecast mode only as long as the document status 
is In Process. 

TIP 
For more information 
about attachments, see 
the Focus on Files, 
Attachments and the 
Catalog Dashboard 
guide.  For more 
information about routes, 
see the Focus on Routes 
guide. 
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Forecast 
Options Menu 

The Options menu for the Forecast document offers the following 
choices after you save: 

 

Statuses for 
Forecast 

By default, the Status drop-down offers the following choices: 

 
• While the document is Pending, you can make some changes to 

the document itself but not to the BFA workbook.  You must 
change the status back to In Process to edit the workbook. 

• Canceled and Approved are final statuses, which close the 
document.  When a Forecast document is Canceled or 
Approved, it can no longer be edited. 

 

 

 

 

 

 

 

 

TIP 
A description of all 
Document Options menu 
choices can be found on 
in the Focus on 
Document and Item 
Basics guide. 

In Process Pending 
Approved 

Canceled 
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Period Distribution 
Overview 

Period Distribution documents contain the Period Distribution workbook, 
which draws information from your current budget so that you can spread 
project budget costs over financial periods representing the life of the 
project.   

 
 

 

 

 

 

 

 

 

 

 

 

 

 

TIP 
For more information, 
see the Focus on 
Budgets and Period 
Distribution guide. 
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Where It Fits In 
Before you can create any Period Distribution document, the Initial 
Budget document’s status must be Approved. Period Distribution allows 
for two different workflows.   

• Your initial budget includes initial amounts, which are then 
distributed by period through the PD workbook. 

• Your initial budget has all amounts set to zero.  Amounts are 
entered through the PD workbook and then posted back to the 
budget.   

Fiscal Period 
The Period field on the Details tab is used to indicate the fiscal period to 
which the approved Period Distribution should post.  The Period can be 
changed in the format YYYYMM (for example, 201103 for March 2011).   

 

The Post To 
Option 

Through Customization, the Post To option can be included on the 
Period Distribution document: 

 

Creating a 
Period 

Distribution 
Once a project has an approved budget, Period Distribution documents 
can be created at any point during the project’s life cycle. 

 

To create a Period Distribution document: 

1. Click  at the Project Dashboard to start a new Period 
Distribution document. 

2. (optional) Change the Description and type a Note. 

3. (optional) Change the Period on the Details tab if you want to 
post to a different fiscal period. 

4. Click  to save (and actually create) the document.   
Note: the  icon will not appear until the first time you save the 
document. 

With this option, you can 
change the target of the 
PD workbook by checking 
and unchecking Original, 
EAC and FAC. 
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5. Click  to open the PD workbook. (For more information about 
the PD workbook, see the Focus on Budgets and Period 
Distribution guide.)   

6. When you save and close the PD workbook and return to the 
Period Distribution document, you will notice that the icon has 
changed to . 

7. Add attachments to the document if desired and create a route, if 
necessary.  

8. Either route the document or save the document, then close the 
document window. 

9. You can reopen the document as needed to make changes to it, 
and to change the document status.  You can edit the PD 
workbook only as long as the document status is In Process. 

Period 
Distribution 

Options Menu 
The Options menu for the Period Distribution document offers the 
following choices after you save: 

 

Statuses for 
Period 

Distribution 
By default, the Status drop-down offers the following choices: 

 
• While the document is Pending, you can make some changes to 

the document itself but not to the PD workbook.  You must 
change the status back to In Process to edit the workbook. 

• Canceled and Approved are final statuses, which close the 
document.  When a Period Distribution document is Canceled or 
Approved, it can no longer be edited. 

 

 

 

 

TIP 
A description of all 
Document Options menu 
choices can be found on 
in the Focus on 
Document and Item 
Basics guide. 

In Process Pending 
Approved 

Canceled 
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Service Contract 
Overview 

Available only for equipment projects, Service Contract documents 
largely serve as “wrappers” for attached service contract files. 

 

Where It Fits In 
Equipment projects can have any number of Service Contracts, created 
as needed.  This Doc type is not available for other types of projects.  

Creating a 
Service 

Contract 
Service Contracts can be created at any time during an equipment 
project’s life cycle. 

 

To create a Service Contract document: 

1. Click  at the Project Dashboard to start a new Service 
Contract. 

2. (optional) Change the Description. 
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3. Click  to save (and actually create) the document. 

4. Add other information to the document, as needed. 

5. On the Attachments tab, attach one or more files to the 
document. 

o Click  to attach files from the Spitfire Catalog. 

o Click  to upload or scan files from your computer. 

6. Create a route, if necessary. 

7. Either route the document to another person or save the 
document, then close the document window. 

8. You can reopen the document as needed to make changes to it 
and to change its status. 

Service 
Contract 

Options Menu 
The Options menu for the Service Contract document offers the following 
choices after you save: 

 
 

Statuses for 
Service 

Contract 
By default, the Status drop-down offers the following choices: 

 
• Closed is a final status, which “closes” the document.  When a 

Service Contract document is Closed, it can no longer be 
changed.  

 

 

 

TIP 
A description of all 
Document Options menu 
choices can be found on 
in the Focus on 
Document and Item 
Basics guide. 

Open Closed 

TIP 
For more information 
about attachments, see 
the Focus on Files, 
Attachments and the 
Catalog Dashboard 
guide.  For more 
information about routes, 
see the Focus on Routes 
guide. 
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Service Ticket 
Overview 

Available only for equipment projects, Service Tickets track service-
related incidents. 

 

Where It Fits In 
Equipment projects can have any number of Service Tickets, created as 
needed.  This Doc type is not available for other types of projects.  

Creating a 
Service Ticket 

Service Ticket documents can be created at any time during an 
equipment project’s life cycle. 

 

To create a Service Ticket document: 

1. Click  at the Project Dashboard to start a new Service Ticket 
document. 

2. Change the Description. 

3. Click  to save (and actually create) the document. 
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4. Add other information to the document and create a route as 
appropriate. 

5. (optional) If an Attachment template has been established for the 
Doc type,  will appear on the Attachments tab.  Click on  to 
create the printout file for the document.  This printout file will be 
emailed or faxed to potential customers who are set up as “via 
email” or “via fax” routees (along with other attached files). 

6. Either route the document to another person or save the 
document, then close the document window.  

7. You can reopen the document as needed to make changes to it 
and to changes its status.  

Service Ticket 
Options Menu 

The Options menu for the Service Ticket document offers the following 
choices after you save: 

 
 

Statuses for 
Service Ticket 

By default, the Status drop-down offers the following choices: 

 
• Closed is a final status, which “closes” the document.  When a 

Service Ticket document is Closed, it can no longer be changed.  

 

 

 

TIP 
A description of all 
Document Options menu 
choices can be found on 
in the Focus on 
Document and Item 
Basics guide. 

Open Closed 
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Expense Entry 
Overview 

Available for integrated sites only, Expense Entry documents list and 
track the ongoing expense requests made by employees throughout a 
project.   

 

Where It Fits In 
Expense Entry documents can be created as needed.  If your site is 
integrated, an Approved Expense Entry appears as a Travel and 
Expense Report Entry in Microsoft Dynamics SL and also appears in the 
Expense Report Review & Approval screen, where it is ready to be 
posted and to generate a Microsoft Dynamics SL AP Voucher for 
payment. 

Creating an 
Expense Entry 

Expense Entry documents can be created at any time during the 
project’s life cycle. 
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To create an Expense Entry: 

1. Click  at the Project Dashboard to start a new Expense Entry 
document.   

2. Look up the Employee requesting the expense payment.  The 
employee must have a vendor ID in Microsoft Dynamics SL. 

3. Select a an expense Type from the drop-down. 

4. Click  to save (and actually create) the document. 

5. On the Items tab, Add New Items.  The sum of all Items will 
appear on the Summary tab. 

6. Add attachments and create a route, if necessary. 

7. Either route the document to another person or save the 
document, then close the document window. 

8. You can reopen the document and change the status as 
appropriate.   

Approving the 
Expense Entry 

To Approve the Expense Entry: 

1. When you are ready to approve the Expense Entry, enter an 
Expense ID number, if one isn’t there already. 

2. Look up an Approved By person. 

3. Change the status to Approved.  

4. Save the document. 

Note: if you are integrated with Microsoft Dynamics SL, approving the 
Expense Entry also sends the information to the Expense Report Review 
& Approval screen, where you can process (post) the Expense Entry 
(Report) to create an AP Voucher for payment. 

Expense Entry 
Options Menu 

The Options menu for the Expense Entry document offers the following 
choices after you save:  

  

Of Particular Note 
•  indicates the person who is requesting payment. 

TIP 
A description of all 
Document Options menu 
choices can be found on 
in the Focus on 
Document and Item 
Basics guide. 

TIP 
For more information 
about the Items tab, see 
the Focus on Document 
and Item Basics guide. 
For more information 
about attachments, see 
the Focus on Files, 
Attachments and the 
Catalog Dashboard 
guide.  For more 
information about routes, 
see the Focus on Routes 
guide. 
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Statuses for 
Expense Entry 

At first, the Status drop-down offers the following choices: 

 
• After you save the document, more choices appear: 

 
• Canceled and Approved are final statuses, which “close” the 

document.  Once Canceled or Approved, the Expense Entry 
cannot be edited. 

• If the Expense Entry is Approved and your site is integrated, a 
Travel & Expense Report Entry is created in Microsoft Dynamics 
SL and the Expense Entry information is available in the 
Expense Report Review & Approval screen, where you can 
select it and generate a Microsoft Dynamics SL AP Voucher for 
payment. 

 

 

 

 

 

 

In Process 

Canceled 

Completed 

Approved 

Rejected 
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Charge Entry 
Overview 

Charge Entry documents, available for non-integrated sites only, keep 
track of all your actual expenses (time and material) that are not covered 
by Pay Requests.   

 
 

Where It Fits In 
A Charge Entry document can be created outside specific projects and 
can track expenses for several projects at once. For this reason, it can 
be considered outside the project workflow. 

Fiscal Period 
The Post Period field on the Details tab is used to indicate the fiscal 
period to which the approved Charge Entry should post.  The Period can 
be changed in the format YYYYMM (for example, 200904 for April 2009).  
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Creating a 
Charge Entry 

There are two ways to create a Charge Entry document: 

• Outside of any project, from the File menu 

• From a Project Dashboard 

Note: the Charge Entry Doc type must be site active for it to be used.  If 
it does not appear, see your System Administrator. 

 

To create a Charge Entry from the Site Options menu: 

1. Select Create Document: 

 
2. Select Charge Entry. 

 
The Task document window will open 

3. If this Charge Entry will include Items from more than one 
project, leave the Project field blank. Otherwise, you can look up 
a Project ID. 

4. Continue with step 2 in the section below. 

 

To create a Charge Entry from the Project Dashboard: 

1. Click  to start a new Charge Entry.    

2. Enter a useful description in the Description field.  This text will 
also be used as the title. 

3. Click  to save (and actually create) the document. 

4. (optional) On the Details tab, change the Post Period field if you 
want the total expense to post to a different fiscal period from the 
one that appears by default. 

5. Add New Items on the Items tab.  For each item: 

o Look up a Cost Code and Account Category. 

o (optionally) Edit the Description that was populated 
automatically by the Cost Code. 

o Look up an Entity (i.e., the person or company who will 
be paid). 

TIP 
For more information 
about the Items tab, see 
the Focus on Document 
and Item Basics guide. 
For more information 
about attachments, see 
the Focus on Files, 
Attachments and the 
Catalog Dashboard 
guide.  For more 
information about routes, 
see the Focus on Routes 
guide. 
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o Look up a Project, if appropriate. 

o Enter an expense amount, either as Units and Rate or 
as a total Extended amount. 

6. (optional) Add other information to the document, as necessary. 

7. Add attachments if desired and create a route if appropriate. 

8. Either route the document or save the document, then close the 
document window. 

9. You can reopen the document as needed to make changes to it 
and to change its status.  

o As long as you don’t route the Charge Entry document, it 
will remain in your Inbox (on the Home Dashboard).   

o If you need to find a Charge Entry document that has left 
your Inbox, especially if it is not within any project, go to 
the Catalog Dashboard and use the Type filter (and 
Include Closed filter, if the Charge Entry status is 
Approved), for example: 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

10. When the Charge Entry is ready to be approved, enter an 
Approved date and change the status to Approved (or, if the 
charge is not approved, change the status to Closed).  

Actual Amounts 
on the Project 

Dashboard 
When a Charge Entry document is Approved, all projects listed within its 
Items are updated to reflect the corresponding charge amounts.  
Specifically, the project’s KPI and Cost Analysis Detail on the Project 
Dashboard, and BFA in Analysis mode show the amounts as Actuals. 
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Charge Entry 
Options Menu 

The Options menu for the Charge Entry document offers the following 
choices after you save: 

 
 

Statuses for 
Charge Entries 

By default, the Status drop-down offers the following choices: 

 
• Closed and Approved are final statuses, which “close” the 

document and make it read-only.  When a Charge Entry 
document is Closed or Approved, it can no longer be changed. 

 

 

 

 

  

Closed 

Approved 

Open 

TIP 
A description of all 
Document Options menu 
choices can be found on 
in the Focus on 
Document and Item 
Basics guide. 
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Production Units 
Overview 

Production Unit documents are aggregated to update BFA financial 
information for Actual and Current units of production at the Cost Code 
level.   

 

Where It Fits In 
Production Unit documents update future BFA workbook snapshots on 
projects that have an approved Initial Budget.   A project can have any 
number of Production Unit documents. 

Creating a 
Production 

Units  
To create a Production Unit document from the Project Dashboard: 

1. Click  to start a new Production Units document.    

2. Enter a useful description in the Description field.  This text will 
also be used as the title. 
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3. Click  to save (and actually create) the document.  The 
system will gather the current financial snapshot information: 

 
4. Select Get Existing from the Items Options menu: 

 
 
Your budget cost codes will be listed. 

 
5. Click the All Filters checkbox to expand all filters. 

6. Specify a UOM filter.  For example, enter a specific Unit of 
Measure such as CY (cubic yard) or enter % for all cost codes 
with a unit of measure. 

TIP 
For more information 
about the Items tab, see 
the Focus on Document 
and Item Basics guide. 
For more information 
about attachments, see 
the Focus on Files, 
Attachments and the 
Catalog Dashboard 
guide.  For more 
information about routes, 
see the Focus on Routes 
guide. 
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7. Select the applicable cost codes for this Production Units 

document and click . 

8. Click  to Add Items. 

9. (optional) Add other information to the document, as necessary. 

10. Add attachments if desired and create a route if appropriate. 

11. Either route the document or save the document, then close the 
document window. 

12. You can reopen the document as needed to make changes to it 
and to change its status. 

13. When the Production Units document is ready to be approved, 
change the status to Approved.  The BFA workbook will be 
updated only after the Production Units document is approved. 

Actual Units on 
the BFA 

Workbook 
When a Production Units document is approved, the Cost Codes listed 
within its Items are updated on the next BFA workbook snapshot to 
reflect the corresponding unit amounts.  Specifically, the Actual Units 
column shows the unit amounts that were entered on the Production 
Units document. 

Note: the Actual Units column must be made visible and the Display 
Units set to Yes on the BFA workbook through the Setup worksheet.  
For more information, see the Working with Production Units technical 
white paper. 
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Production 
Units Options 

Menu 
The Options menu for the Production Units document offers the following 
choices after you save 

  
 

Statuses for 
Charge Entries 

By default, the Status drop-down offers the following choices: 

 
  

• Canceled and Approved are final statuses, which “close” the 
document and make it read-only.  When a Production Unit 
document is Closed or Approved, it can no longer be changed. 

 

 

 

 

 

 

 

 

 

 

 

TIP 
A description of all 
Document Options menu 
choices can be found on 
in the Focus on 
Document and Item 
Basics guide. 

Canceled 

Approved 

In Process 
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Catalog File Route 
Overview 

The Catalog File Route document is a special document created by 
sfPMS for the sole purpose of routing a file to another person, thus 
allowing all Catalog files to be routed.   

 

Where It Fits In 
Catalog File Route documents are created when you choose to route a 
file from the Check In dialog box or File Options menu.  A Catalog File 
Route document with its file attachment can then be routed as usual.  
Because they are Spitfire documents, Catalog File Routes can be found 
through the Catalog. 

Creating 
Catalog File 

Route  
There are two ways to create a Catalog File Route document. 

• From the File Options menu for any file. 

• From the Add Files tool. 
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To create a Catalog File Route document from the Options menu: 

1. Click  at the file to open its Options menu. 

2. Select Route This to create the Catalog File Route document. 

 

3. Click  at the confirmation dialog box that appears. 
 
The document will open. You will notice that the file is attached 
to the document. 

4. Build your route on the Route Detail tab. 

5. Click  to send the document and attached file to the next 
routee. 

 

To create a Catalog File Route document from the Add Files tool: 

1. After you have selected your file(s) through the Add Files tool, 

click the down arrow on the  button.   

2. Mouse over the Route Files option then choose either to route all 
files in one Catalog File Route document (Together) or route 
each file on its own Catalog File Route document (Individually) 
 

 

3. Click  to add the file to the Catalog (and Project Dashboard 
and document, if appropriate). 

4. Find the newly created Catalog File Route document(s) either in 
your Inbox or through the Catalog Dashboard. 

5. Open (each) Catalog File Route document to build your route on 
the Route Detail tab.  

6. Click  to send the document and attached file to the next 
routee. 

TIP 
For more information 
about files, see the Focus 
on Files, Attachments 
and the Catalog 
Dashboard guide. 
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Customer, Vendor, Employee 
Overview 

The Customer, Vendor and Employee documents are created by sfPMS 
to hold additional information and pertinent attachments for Customer, 
Employee and Vendor Contacts.     

 
 

 

 

 

 

 

 

 

 

 

 

 

 

On integrated sites, the 
status is set in Microsoft 
Dynamics SL. 



 Page 185 

Focus on Doc Types and Project Workflow  Contact-related Documents 

Where They Fit 
In 

When you create a new Contact in Spitfire or sync Contact information 
from Microsoft Dynamics SL to Spitfire, an empty associated (Customer, 
Vendor or Employee) document is also created. 

Compliance 
Tab on Vendor 

By default, the Vendor Doc type includes the Compliance tab, where 
compliance requirements are tracked for the specific vendor. 

 

Opening a 
Customer, 

Employee or 
Vendor 

Aside from being available from the Catalog Dashboard, Customer, 
Employee and Vendor documents can be opened from the Contact 
Detail window. 

To open a corresponding document from the Contact Detail 
window: 

1. Open a person or company’s Contact Detail window (for 
example, from the Contact Dashboard). 

2. On the General tab, notice the Type.   

3. Click  to open the document associated with the Type 
(Customer, Vendor or Employee). 
Note: if you create a new Contact, you will need to select the 
Type and save before the appears. 

 
The document will contain some information about the Contact, 
such as Name/Description. 

4. Fill out appropriate fields (especially for Vendors). 

5. Add attachments if desired and create a route if appropriate. 

TIP 
For more information about 
these Doc types, see the 
Focus on Contacts guide. 

TIP 
For more information 
about compliance 
tracking, see the Focus 
on Alerts and 
Compliance guide. 
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6. Either route the document or save the document, then close the 
document window. 

7. You can reopen the document as needed.  

Customer, 
Employee, 

Vendor  
Options Menu 

The Option menu for the Customer, Employee and Vendor documents 
offers the following choices after you save: 

 

Of Particular Note 
•  links to Microsoft Dynamics SL (if your site is integrated). 

•  opens the Contact Detail window for the Contact associated 
with the document. 

Statuses for 
Customer  

By default, the Status drop-down offers the following choices: 

 
• If your site is integrated, the status is set in Microsoft Dynamics 

SL.  If your site is not integrated, you can use any of these 
statuses to label a Customer.  No status closes the document. 

 

 

 

 

TIP 
A description of all 
Document Options menu 
choices can be found on 
in the Focus on 
Document and Item 
Basics guide.  

Inactive 

One Time 

Active 

Hold 
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Statuses for 
Vendor, 

Employee 
By default, the Status drop-down offers the following choices for non-
integrated sites. 

 
• Closed is a final status, which “closes” the document.  When a 

Vendor or Employee document is Closed, it can no longer be 
changed.  

Open Closed 
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Doc Types Created From Microsoft Dynamics SL 
If your site is integrated with Microsoft Dynamics SL, there are some Doc 
types that are created from within Microsoft Dynamics SL.  These 
documents function as any other Spitfire documents.  This means that 
you can attach files to these documents and route them as usual.  These 
documents also provide a link back to Microsoft Dynamics SL (if you are 
authorized). 

Creating a 
Spitfire 

Document from 
DSL 

• To create a Spitfire document, use the Doc Control button on the 
corresponding Microsoft Dynamics SL screen (identified for each 
Doc type in the following pages). 
Note: once the Spitfire document exists, the Doc Control button 
can access the document again from Microsoft Dynamics SL. 

Options Menu 
The Options Menu for these documents offers the following choices after 
you save: 

 

Of Particular Note 
•  links back to Microsoft Dynamics SL.  

 

 

 

 

 

 

 

 

 

 

TIP 
A description of all 
Document Options menu 
choices can be found on 
in the Focus on 
Document and Item 
Basics guide. 
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AP Voucher 

Overview 
AP Voucher documents are created through the Microsoft Dynamics SL 
Voucher and Adjustment Entry screen for approved Pay Requests and 
project related expenses.   

 

Reviewing an AP 
Voucher 

AP Vouchers connect the actual expense to its project management 
history, such as the payment request and original subcontract.  

Aside from the usual locations (Project Dashboard menu, Catalog), AP 
Vouchers can also be opened from the Cost Analysis Details part and 
the BFA workbook. 

 

To open an AP Voucher document from Cost Analysis Details: 

1. Go to the Cost Analysis Part of your Project Dashboard. 

2. Click on a number in the Actuals column, for example, for the 
Subcontractor (_SUB).  A Transaction History window will 
appear: 
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3. Click  to open any of the Vouchers listed. 

 

To open an AP Voucher document from BFA: 

1. Open a Budget document and click  to open the Microsoft 
Excel BFA workbook desired. 

2. Get to the desired cell in the Actual Cost to Date column.  (You 
may have to expand the column.) 

3. Right-mouse-click to pull up the Transaction History window: 

 

4. Click  to open any of the AP Vouchers listed. 
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Other Doc 
Types 

Most Doc types created by Microsoft Dynamics are very basic, with no 
Mid-section tabs, for example: 

 
 

You can create this Spitfire Doc type From this Microsoft Dynamics SL screen 
AR Invoice Invoice and Memo 

Cash Trans Cash Account Transactions 

CBE Construction Billing Entry 

DSL – SPR  
Note: this Doc type is mutually exclusive 
with the Pay Request Doc type 

Subcontract Payment Request Entry  
 

GL Journal Trx Journal Transactions 

Inv & Adj Invoice & Adjustment Maintenance 

Item Request Item Request 

Pct Billing Percent Complete Entry 

PO 
Note: this Doc type routes the PDF of 
the purchase order to external vendors 

Purchase Order Maintenance 
 

Requisition Requisition  

Service Call Entry Service Call Entry 

Timecard Timecard Entry 

Timesheet Project Timesheet with Rate/Amount Entry 
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